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Overview of Mountbatten Brailler Tutor 

Introduction  
The Mountbatten Brailler Tutor has features that make it a braille writer, braille printer, 
braille notetaker, braille-print interface, and a student-teacher or child-parent 
communication tool. Still, the essential function of this unique device is that the 
Mountbatten Brailler Tutor helps with learning braille and that it is the first valuable IT 
experience for kids. It does teach new concepts about layout (words, lines, paragraphs 
and pages), the relationship of braille to print, and phonetics to spelling. It also introduces 
saving digital copies and transferring text files between devices. 

This new version of the Mountbatten Brailler, called the Tutor, focuses on student-teacher 
and child-parent interaction, giving many opportunities to share tasks, assignments, and 
text files and engage in fun learning activities. 

You will discover that the unit has many extra features like erase and correct, formatting, 
and more. For more details, see the section "Embossing". 

The speech output gives immediate feedback, helps you remember each character 
learned and lets a beginner braille user discover new characters. Synthetic speech reads 
words and sentences, too, even if entered with braille contractions. 

The embedded display shows either the internal menu system or what the user is 
brailling. The display helps sighted people (such as teachers and parents) to operate the 
unit even if they don't know braille. The braille can be entered in any Grade (Grade Zero 
computer braille, Grade 1 uncontracted braille, or Grade 2 contracted braille) – and the 
resulting embossed braille will be spoken back by the Mountbatten Tutor, as well as 
displayed in back-translated form as a standard print on display. 

The Mountbatten Wireless Keyboard makes the braille machine convenient for 
everyone, including small children or persons with multiple disabilities (even while using it 
in a wheelchair). Another feature designed for people with disabilities is the one-handed 
keyboard mode. You don’t need another extra device to use your unit with one hand - the 
keyboard can be switched to one-hand mode easily - with a single command or a menu 
option. 

Inside the device is a Li-Ion rechargeable battery that lasts up to 30 pages of embossing 
or a few days of work when embossing only a smaller number of pages. The battery 
charges whenever you are connected to the mains through the Power Supply, and you 
may continue working while the battery charges. 

The MB Tutor in Graphic Mode can make dot patterns and pictures. 

Another crucial feature is the possibility of playing braille-learning games that help with 
computer skills. Some games – like Keyboard Master, are embedded in the device; 
others will be available for download on the Internet. Contact us for more games by visiting 
the Mountbatten website, www.mountbattenbrailler.com. 
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You can use the MB Tutor in lots of languages and in lots of ways. For language students, 
this can be very helpful! 

Mountbatten Brailler Tutor produces minimal noise while embossing, even on thick braille 
paper. To limit even that, you can write into the Editor and only emboss later; you can 
come back and make changes, save them again, and still not emboss until you're ready. 
So you can use the MB Tutor in a classroom without the noise of braille disturbing other 
people. 

Unpacking the Mountbatten Brailler Tutor 
Inside the outer carton, you will find the MB Tutor packed in a backpack with foam filling to 
support it inside the carton. We have packed everything you need to use the MB Tutor.  

Please keep ALL the packaging. If you have to return the MB to us for service, or if you 
have to ship it somewhere, it MUST be packed in this original packaging so it doesn't 
suffer damage in transit. 

When you receive your Mountbatten and unpack it, please check that you have received 
the following: 

● The Mountbatten Brailler Tutor main unit with Top Cover and Reading Table 
attached 

● The Mountbatten Wireless Keyboard 

● This User Guide 

● Quick Start Guide - a "must read" for those who don't want to read the entire User 
Manual; a proper reading just after you get the unit delivered 

● An AC mains Power Supply 

● A power lead to connect the power supply to the wall socket appropriate for your 
country 

Please get in touch with your distributor or us immediately to supply you with any missing 
items. 
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The top cover 

Fig. 1 Removing the top cover of the Mountbatten Brailler Tutor 

The top cover must be removed before you use your Mountbatten Brailler Tutor.  

Remove the top cover by reaching over to the MB Tutor's rear and lifting the cover's rear 
part towards you. Place the cover to one side. The cover comes off very quickly. Under the 
Top Cover, you will find the Reading Table easily detached from the Cover (mounted with 
magnets). 

Removing the shipping restraint 
Wait to switch the MB Tutor on! First, you MUST remove the shipping restraint, or you 
could damage your new MB Tutor. Remove and store it for future use. 

When you have the MB Tutor out of its box, sit it on the table before you, with the display 
towards you. The keyboard may stay away for a moment. 

The reading table 

Fig. 2 Installing the Reading Table 

The reading table can be optionally mounted in its narrow groove, as in the picture above. 
If you want to read more than three last embossed lines of braille, you will need the 
reading table to make the reading array reach the last embossed seven braille lines. 
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Fig. 3 Removing the paper bail 

Removing the paper bail 
The paper bail is only needed when the MB Tutor operates as a braille embosser. When 
using the MB Tutor as a braille writer, we recommend removing it because it is difficult to 
read the braille just written with the paper bail in place. 

First, lift the paper grip lever on the right to remove the paper bail. Then, slide the right-
hand margin adjuster as far right as it will go (if the top cover with the reading table was 
just taken away, the right margin is already in its far-right position). The adjuster will only 
move if the paper lever has been lifted. 

A small spring-loaded sleeve is on the left-hand end of the paper bail. Take this sleeve 
between your fingers and push it to the right, releasing the left side of the paper bail from 
its slot. You can then pull the paper bail towards the left to release it from the slot on the 
right. Lift the paper bail out and put it to one side. 

We suggest you store the paper bail and the shipping lock in the carton to find them easily 
when needed. 

The wireless keyboard 
The Mountbatten Tutor wireless keyboard is packed with the main unit in the inner box. It 
should be pre-charged when shipped, but for best performance, we advise putting it in 
front of the main unit magnetically docked, attaching the main unit to mains via the 
attached power supply, and charging for 12 hours. The device may be used during that 
time, but the keyboard should stay docked because it is charged in this position. 

Description  of your new Mountbatten Brailler Tutor 
The Mountbatten Brailler Tutor consists of the main unit and a detachable wireless 
keyboard. The main unit is a compact device with a leather carrying handle. It has an On/
Off button in front (front left side) and connectors on the right and left panels. On the right 
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side – closer to the user, you will find a multi-purpose dial for adjusting volume, paper 
position, and embossing speed. 

Mountbatten Brailler Tutor connectors include: 

On the right-hand side of the unit: 

● Power Supply connector – use only with the accompanying Power Supply unit 

● Slave USB connector (Type B, used to connect to a PC) 

● Universal Type A USB master connectors (used to connect external QWERTY 
keyboard, USB drives, and other USB peripherals); because these connectors 
supply power, they are marked with this symbol indicating direct current: 

● Headphone connector 

On the left-hand side of the unit: 

● The printer and other peripheral USB connectors are on the left side; because these 
connectors supply power, they are marked with this symbol indicating direct current: 

Mountbatten Brailler Tutor wireless keyboard 

Mountbatten Brailler Tutor wireless keyboard feels different from other braille 
keyboards you may have used. Practice a little with it, and you will find you can 
braille faster and for more extended periods than ever because of the ergonomic 
design. 

The Mountbatten Brailler Tutor keyboard is wireless. It continually charges when put 
into its docked position in front of the Mountbatten Brailler, and the unit is 
connected to mains. Even when the unit is not connected to the mains, it charges 
your keyboard (when docked) but only when turned on - to save the main unit 
battery. 

When the keyboard gets discharged (when put away from the main unit for too long), it 
should be placed in front of the main unit so that the magnets connect the keyboard for 
charging (what we call "docking the keyboard"). It takes several minutes to start working if 
the keyboard is completely discharged. 
Key descriptions and layout 
The key names are used throughout this manual to describe commands and provide 
general operating information. See the graphic insert for reference. 

P1 .. P8 	 = 	 Perkins keys 1..8 
Esc	 	 =	 Escape keyboard (upper-left key) 
TAB	 	 =	 Tab key (below Escape key) 
BS 	 	 = 	 Backspace key (upper-right key) 
Ent 	 	 = 	 Enter key (below Backspace key) 
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SP 	 	 = 	 Space (long key in the lower part of the keyboard) 

Command Key (round key in the middle of the keyboard 4-way manipulator in the lower-
right part of the keyboard) 
As you may notice, the keys are placed similarly to any regular PC keyboard. That 
introduces essential computer concepts that the young user will use in the future. 
To navigate the page up and down, you may use the 4-way manipulator. As you can see 
from the above description - there is no manual paper advance knob or wheel in the unit. 
You need to use the electronic 4-way manipulator or manually release the paper by lifting 
the paper lever. After setting the paper lever back to the operating position, the unit will 
assume it is now at the beginning of a page.  
Additionally, when Space is pressed, the dial to set the volume (on the right side of your 
unit) will move the paper in small steps. This helps adjust the vertical paper position 
more finely. 

One-handed keyboard mode 
One-handed mode is meant for persons with multiple disabilities who can't use both hands 
to press multiple keys at the same time – the regular way of using a Perkins-type braille 
keyboard. Press the space after the dots that build each character when this mode is on. 
For example: 

To type the letter u, you do not have to press dots 1, 3, 6 together. You can press the 
dot keys separately in any order. For example, using one finger, press dot 3, then dot 
1, then dot 6. Then press space to emboss the character. 

To turn the one-handed mode on, use the Menu/Keyboard/One hand mode or enter the 
{ku} command. For more information on entering commands, please see the "Menu and 
commands - how to use them" section below. 
To return to standard two-handed keyboard use, remember to use Command, dot 1, dot 3, 
space, dot 1, dot 3, dot 6, space, and enter; or go into the Menu/Keyboard/One hand 
mode and press Enter to toggle back to normal mode. 

Using an external QWERTY keyboard 
An external USB computer keyboard can be connected to either one of the USB 
connectors on the right side of your Mountbatten Brailler Tutor. It is a convenient tool for 
communication between blind MBT users and persons who don’t know Braille. Typing 
characters on the QWERTY keyboard in a standard setup will produce braille on paper. 
And you can also braille with contractions (when you turn forward translation on).  
Read about using a PC keyboard in the Using a PC Keyboard section in Advanced 
features of MB Tutor/Forward Translation Settings. 

Power and battery  
The MB Tutor has an internal rechargeable battery. A universal power supply is provided, 
which, when plugged into the mains, will recharge the battery; simultaneously, it gives 
power to the unit. It connects to the MB Tutor through the round connector on the right-
hand side of the unit that is closest to the back. 
You cannot over-charge the battery, and leaving the unit permanently charging will not 
damage it. Still, to maintain exact information on the charge level, you should discharge 
the battery from time to time. You typically get a full day out of the battery for regular 
classroom use. When you do this, please recharge Tutor overnight so it is ready for the 
next day's work (unless you find out that your battery is good for several days, which 
happens quite often if you don’t emboss too many pages while working on it). 

Mountbatten Brailler Tutor User Manual v. 1.1	 Page 10



How to check battery status 
Whenever the Mountbatten is switched on, the battery status is spoken. You may check it 
manually by pressing the M chord (Space + D134 = Press all four keys together: Space, 
dot 1, dot 3, and dot 4).  
The MB Tutor will also tell you the percentage of the battery charge and whether it is 
charging. If the battery is flat, embossing will stop. 
Note: The causes of a flat battery are: 

• The battery hasn’t been charged. Connect to power for 4 - 8 hours. 
• The wrong power supply is being used (all MB-Tutor units are supplied with a 

proprietary power supply 110v – 220v Output 15-19VDC 5.5Amp, 90W).  
• The power cable could be broken. 
• There could be no power coming through the wall outlet. 
• The battery is damaged and needs replacing (the expected life is four years, but 

after two years of use, its health may worsen and lose some of its capacity). 

How to check keyboard battery status  
The keyboard battery status can be checked by pressing the K chord (Space + D13 = 
Space, dot 1, and dot 3). The system will read the battery charge as a percentage of full 
charge. The keyboard itself will answer with a series of lower and higher pitch beeps that 
have the following meaning: 
- lower pitch beeps sounding first: 
	 - 4 short - the battery is charged at more than 80% 
	 - 3 short - the battery is charged at more than 50% but less than 80% 
	 - 2 short - the battery is charged at more than 20% but less than 50% 
	 - 1 long - the battery is charged less than 20% 
- higher pitch beeps sounding after the lower pitch beeps: 
	 - single short - wireless charging 
	 - double short - charging through USB cable 
	 - long beep - battery fully charged 
The keyboard beeps will sound even if there is no connection to the main unit. 

Powering On/Off Mountbatten Brailler Tutor 
To power on, it takes a short press of the On/Off button in front of the main unit – near the 
left edge. It is marked with this symbol:  

The main operation starts in a few seconds.  

The advanced functions (synthetic speech, games, calendar, Internet connectivity, and 
other unit management features) start automatically within 2 - 3 minutes. You will hear 
"Advanced Mountbatten Brailler Tutor functions are available now" when the full 
functionality is on. 

To power off, you must press and hold the On/Off switch for at least half a second (shorter 
presses will be ignored). If the power off command is accepted, you will hear a "bye, bye" 
prompt followed by a series of short sounds/beeps signalling that the system is closing. 
After the successful close, you will hear three consecutive short sounds with decreasing 
pitch, and the device will turn off. 
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In case of any problems with stopping one of the internal systems, the power management 
unit inside the Mountbatten will force-switch off. If you need to force-switch off the system 
manually, keep the On/Off switch pressed for 10 seconds. Using this method too often is 
not good, as some internal systems may sometimes fail to save some data. 

Procedure to reset the MB Tutor 
If you think settings are mistakenly set and don’t know how to reset them to normal, it is 
advisable to go to the System menu and choose "Restore all settings." This will restore the 
last saved configuration (it is a good practice to keep one that fits your needs and works 
well for your type of work). 

If this doesn’t work for you, there are two simple methods for resetting your Mountbatten 
Brailler Tutor: 

1. Soft reset - if your device becomes non-responsive, but you want to retain all settings 
and restart the machine, press the middle button of the four-way manipulator (Command 
button) for at least 5 seconds. This will make the device start all over but without 
changing the settings. 

2. Hard reset - this method requires a ballpoint pen or another implement with a sharp tip 
to press a hidden button that can be found on the right-hand side of the unit between 
USB type A and USB type B connectors. Pressing this button restarts the machine, even 
for a major glitch in the system. It does not make it forget settings, however.  

Mountbatten Brailler Tutor User Manual v. 1.1	 Page 12



Loading paper 
There are two methods for loading paper. Try each way to find the one that suits you best. 

Fig. 5: The four steps for loading paper into the MB Tutor. 

Loading Paper: Method 1 
The first method is very similar to loading paper into a typewriter. 

1. Lift the Paper Lever and slide the right-hand margin to the position that suits the paper 
size. Lay the paper flat on the Reading Table. Ensure the paper is positioned 
underneath the small rollers on the left and right margins and under the embossing 
head. 

2. Slide the paper into the unit. Some people grasp either side of the form and push it in. 
Others prefer to slide it in by pressing on the Reading Table and pulling the paper 
towards you. 

3.  When the paper is fully inserted, align the top of the page to the groove - behind the 
paper bail (if that is still in place).  

4. Check that the paper is placed straight against the left-hand margin. In case it isn’t - 
slide the right margin to the left until it rests against the right edge of the paper under the 
small roller wheel. Flip the Paper Lever to the down position. The embossing head will 
now move to the right margin adjuster and back to check the paper size.  
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The machine is now ready for embossing. 

Loading paper: Method 2 
The second method involves inserting the paper from the rear of the MB Tutor. 

Fig. 6: Loading paper from the back of the MB Tutor 

First, lift the Paper Lever. Check if the right-hand margin is set to the position that suits the 
paper size. Then locate the Paper Input Slot at the rear of the Mountbatten Brailler and 
insert the top of the page into it. Push the paper in until it appears on top of the Reading 
Table. Align the form, adjust the Right Margin Adjuster as needed, and move the Paper 
Lever to the down position. 

Removing paper 
Lift the Paper Lever and pull the form back and out of the MB Tutor to remove the paper. 

For users who cannot pull the paper out of the back of the Mountbatten Brailler, it is 
possible to eject the page from the keyboard. There are three ways to do this: 

• P-chord	 - Page eject. Press p and space together: dots 1, 2, 3, 4, and space. 

• NP		 - Force a new page command issued with the Command key, the 
command NP, and then the Enter key. 

• The menu command "Force new page’ in the Emboss menu. 

Your Mountbatten Brailler will say "Page Eject," and the paper will be rolled out of the 
machine, ready to be collected. 

Moving the paper sheet up and down 
To move the paper ahead (up) or backward (down) while a sheet is installed and the paper 
lever down, you may press the space key on your keyboard and move the volume dial. 
Alternatively, use the space key and four-way manipulator up and down. 

Speech options 
All models of the series of Mountbatten Brailler Tutor have speech output to support braille 
learning. There are two different types of speech output available in MB Tutor: 
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• Recorded Speech is a synthetic voice recorded digitally; all prompts are stored in the 
machine. It is a high-quality voice that is easy to understand and is intended for the early 
learner. Only vocabulary that has been recorded can be spoken.  

• Synthetic speech has an unlimited vocabulary, and the speech parameters such as pitch 
and rate can be adjusted to suit the user. 

The powerful speech options in the MB Tutor enable a wide range of features that assist in 
learning braille and using braille as the communication medium of choice. 
Speech can be used: 
- to re-enforce the learning of braille,  
- to enable silent note-taking (no embossing), 
- to facilitate word processing of files in memory, 
- to speak all contractions with unlimited vocabulary. 

Volume control 

Mountbatten Brailler Tutor has a dial on the right side. Moving it away from yourself will 
increase the volume of all sounds from the Tutor’s loudspeaker (or from headphones if 
attached). While you turn it, you will hear MB speak "louder."  

Remember not to press any key on the Tutor’s keyboard while turning the dial. Pressing 
specific keys while turning the dial has other functions described later.  

To lower the volume, you need to turn the dial towards yourself. While you turn it, you will 
hear MB speak "softer." You will listen to an announcement when you reach the minimum, 
not accidentally leaving the unit mute. 

There is an alternative method for volume control: press and keep the Tab key on the 
keyboard pressed and turn the wheel on the four-way manipulator right to increase volume 
or left to decrease. 

Loudspeakers and headphones/earphones 

Mountbatten Brailler Tutor uses high-quality speakers to produce its speech and other 
sounds. You may use headphones or earphones to maintain privacy and not disturb 
people nearby. To connect headphones, you need a 3.5 mm audio jack connector at the 
end of the cord. Connect it to the socket next to the volume dial. When you plug it in, the 
loudspeakers will get turned off.  

Embossing 

Paper you can use for embossing  
Writing braille onto paper makes noise. Mountbatten Brailler Tutor is relatively quiet 
compared to other braille devices. There is no way to avoid noise altogether with a braille 
writer. However, there are strategies and procedures to help minimise it. 

The first strategy is to use lighter paper because it is quieter and more affordable. Braille is 
produced adequately on more lightweight paper, lasts well, and is readable with good-
quality dots. 

The MB Tutor has been designed to work best and most quietly with regular office paper. 
This is 80 gsm or 20 lbs paper sold for use in photocopiers and printers.  
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The strike force set up in the factory is correct for this paperweight and equally suitable for 
thick braille paper as used with other braille writers or embossers. 

Using heavy cards or labels 

You can select the number of times the embosser hits each dot to emboss on a thick 
material like cardboard and plastic labels. In some cases, if you are using a heavy card or 
a plastic label with adhesive backing, you may need to use the multi-strike setting to make 
good braille. You can choose from a single strike (default) up to 4 strikes on each dot. 

The commands and menu items that serve a purpose described in subsequent 
sections will be presented in tables for clarity and ease of finding the command 
description. To issue a command, press the Command key for one second until the 
device says "Command".  Then braille or type the command abbreviation, e.g. "MS", 
then space and finally, any parameter, e.g. "3", and press the Enter key. 

Note that numbers in commands can be either in dropped (Nemeth) notation or 
UEBC preceded by a Number Sign.  For example, to enter "3", use either dots 2 5 
Enter OR Number Sign (dots 3 4 5 6) then dots 1 4 Enter. 

Embossing speed              
With the new Mountbatten Brailler Tutor, you can set embossing speed by pressing the 
Esc key and turning the volume dial. Alternatively, Use the Esc key and four-way 
manipulator up and down. 
This adjustment cannot be performed while the machine is embossing. 

Using the keyboard for typing and controlling your device 
Writing braille with Mountbatten Brailler keyboard 

Mountbatten Brailler Tutor has an eight-dot keyboard for languages and braille tables that 
use 8-dot braille or 6-dot braille. 8-dot braille is sometimes used for technical materials. 
Use the six braille keys in precisely the same way as you would type on a regular braille 
writer. Whatever you type will be embossed on paper. If you need eight keys for eight dot 
braille - use all 8. You must use 6 or 8 dots to set language with the appropriate braille 
table.  
The keyboard has a buffer if you type faster than the data is transferred to the main unit. If 
the keyboard is overloaded with inputs and the memory limit is exceeded, the keyboard 
will make a loud error beep. This situation will not disable the keyboard but reset the 
queue of keys waiting to get processed. This way, the user may continue using the 
keyboard without needing a reset. 

How to move around the page 
A simple pressing combination of keys offers unparalleled ease of movement around the 
page. This is of particular importance for setting out math problems and columns. 

Menu item Command Description
Emboss/Multi 
strike emboss

MS [n] Multi-strike feature. Set strikes per dot to "n". Useful for 
brailling on heavy materials such as plastic Braille labels. 
n = 1 to 4.  Default = 1
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4-way Down	 or Space-Enter	 = 	 Move a line down the page in the 
same column 

4-way manipulator Up	 	 	 = 	 Move a line up the page in the same 
column 

P-chord (Space+P letter)	 	 = 	 Page Eject 
Tab 	 	 	 	 	 = 	 Move the head to next tab position 
Space	 	 	  	 	 = 	 Move one position right 
BS		 	  	 	 = 	 Move one position left and erase character 

at that position (the erasure happens after you type next 
character - see below) 

  

Erasing and correction 
Your Mountbatten can erase or correct mistakes. The quality of the corrections is 
approximately the same as for the ‘fingernail method’ and depends on the quality of the 
paper used. 
	 Erasing 

BS	 = moves one space to the left and prepares for the last character erasure; 
the next character will replace the one already there 

BS+Space = replaces a character with a space 
BS+Correct Dots = replaces a character with your desired character 

Keyboard Echo 

When you use braille, the Tutor will speak the letters being brailled; it can also translate 
braille to text (depending on which grade is set) to say words. 

Letters	 On entering text, each character is echoed as it is joined. 
Word 	 	 On entering text, the last word entered is echoed when the space, 

carriage return, or linefeed is joined. 
Line 	 	 Each line you type in is spoken after entering a new line character, or 

MB Tutor performs an automatic new line. 
Sentence	 Each sentence you type in is spoken after entering sentence 

punctuation (like a period, exclamation mark, question mark, 
etc.). 

You may set any combination of the above echo options, including none. 

Using the display while embossing 

While you braille, the display simultaneously shows the ASCII text equivalent of the braille 
characters (symbols that represent braille contractions)  in the upper line of the display. 
The lower line of the display shows the normal print equivalent of what you are brailling. 
When you navigate the page, the display cursor will keep showing where the braille head 
is placed and whatever text and braille are at that position. If you navigate to a point in the 
upper line and braille new characters, you will see both braille and display overwritten with 
the new characters. 

In the Menu, all commands and options will be spoken and displayed on the display.  

Menu and commands - how to use them 
Mountbatten Brailler Tutor is a sophisticated system with many options and features that 
can be switched on or off using the menu system or commands. While using the menu, 
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you get information about the equivalent command. The possibility of entering the 
commands manually is left for users who know the old models of Mountbatten Brailler and 
are fluent in typing commands. Nevertheless, the menu covers most of the commands that 
exist, and the menu shows the state of the command directly if it is a toggle or a number 
value (see below).  
You need to use the four-way manipulator to enter and browse the menu. The manipulator 
has a Command key in the middle. This key is used to: 

- enter the MB menu (short press - shorter than a second) - you will hear "Main 
menu" and the name of the currently selected menu; 

- enter a command manually (long press - longer than 2 seconds) - you will hear 
"Command"; 

- while in the menu - enter a submenu or issue a command under the cursor. 
The four-way manipulator may be used to navigate the menu:  

- up/down to choose between the menu items on the list; 
- left to escape a menu level to a higher one; 
- right to enter a submenu; 
- the command key in the middle of the four-way manipulator is used to choose one 

of the items on a list (e.g., list of files, etc.) or to issue a command. 
Around the Command key, you will find a ring turned left or right. This ring can quickly 
move to an item lower in a menu or list (by turning the ring right) or higher (by turning it 
left). Combined with some modifier keys, the ring may have other functions, like changing 
volume, etc.  
Additionally, the Braille keyboard keys 7 and 8 jump to the first and to the last item in the 
current menu. 

Apart from these two ways of entering commands, you can use keys in combination with 
space. They are called Chorded commands (see below). 

1. Regular commands. 
Regular commands can be found in the menu or entered manually: begin with the 
Command key and finish with the Enter key.  
For example, to turn the Word Wrap command on, you may  

- enter the menu by short-pressing the Command key, scroll down to the 
Emboss menu item (with the manipulator's down-key or the ring's down-
key), find the Word-Wrap command, and press the Command key or Right 
Arrow key on the manipulator.   

- Alternatively, long-press the Command key, type WW, and then hit the Enter 
key.  

Your Mountbatten will say "on" or "off" depending on the original setting. Some 
commands, like Word Wrap, are "toggle" commands, meaning they toggle between 
an on and off state each time they are invoked. These commands are identified as 
toggles after the command description. 
During browsing the menu, you will see the format of each command at the end of 
each menu item. For example, you will see {WW} after the "Word wrap toggle" 
menu name.  
After the command format, you will find the command's state. You will see either an 
(OFF) or (ON) for the exemplary WW - a toggle. 

Note: Where numbers are needed in command, they can be entered as described 
below: 

- when entering commands using the menu - you will be presented a list of 
choices, 
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- when entering commands manually, you need to use the Number sign plus 
character or as a  "dropped" or "lower" character (for example, a dropped 
"A" letter is dot 2 - one dot lower than the original letter; dropped "C" is dots 
2 and 5). 

Note: You may enter commands with an external QWERTY keyboard attached 
through USB. To do it, wrap the command text with curly brackets: "{" and "}" 
characters. The curly brackets are used in this manual to delimit commands too. 
To enter the MB Tutor menu using a QWERTY keyboard, press the Windows key. 

2.  Chorded commands 	 	  
Chorded commands use the space bar pressed with the designated letter key 
combination. 
There is only a limited number of chorded commands, and they can be used at any 
time. 
Some chorded commands have their alternatives - regular commands listed in the 
"Command" column in the table below. 

Learn and Advanced Mode 
Your MB Tutor has two modes: Simplified Mode and Advanced Mode. When your MB 
Tutor arrives, it is in Simplified Mode to let the new user start with the basic functionality of 
the device, not to have the advanced features con in the way while the user learns. 
While in Simplified Mode, the menu will consist of these four items only on the main level: 

- File - the menu with commands that will allow for reading or saving text from files in 
various locations, 

Chorded 
Command

Command Function Additional 
description

Chord B BT Backtab

Chord C CR Carriage  return feed the paper down one line 
without returning the head to the 
initial position 

Chord E End

Chord F LF Line feed

Chord H HP Help

Chord I IN Indent move to the next tab stop (same as 
Chord T)

Chord P NP Page eject

Chord R RL Reverse Line this command feeds the paper up 
one line without returning the head 
to the initial position

Chord T TB Tab move to the next tab stop (same as 
Chord I)

Chord Z Stop the speech Stops the speech (while speaking)
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- Display - with commands for determining how much text will be seen on the visual 
display of the MB Tutor, 
- Speech - here you can set up the voice used by the device - synthetic vs. recorded 
speech, echo settings, etc., 
- More options - this menu contains all advanced features and toggles that in advanced 
mode are in the root of the menu. 

Switching between Learn and Advanced Mode 

To switch to the advanced mode, go to Menu and find More Options -> System -> 
Simplified Mode off. When in advanced mode you can switch to simplified mode by using 
Menu -> System -> Simplified Mode on. 
Below, in the Complete Mountbatten Brailler Tutor Menu section, you will see the detailed 
structure of the Advanced Mode structure. If you need to use the advanced commands in 
the Simplified Mode, remember that they are hidden under the More Options Menu. 

Complete Mountbatten Brailler Tutor Menu 
Below, you will find all menu items and submenus of MB Tutor. In a later section, you will 
find a detailed description of all commands (issued with the Command key) and equivalent 
menu options. 

File menu 

Options in this menu serve to select a file from the device’s memory to be either 
embossed, sent to a connected device (a tablet or smartphone), or opened in the editor. 
After invoking the Append to a file option, you will get a list of files in the current memory. 
With the Set current memory... setting, you may switch between available devices: the 
internal memory of the Mountbatten Brailler Tutor and a USB memory connected to the 
upper USB socket on the right side of the Tutor’s housing. 

The available positions are: 

- Create new file 

- Append to a file 

- Close current file 

- Emboss… 

- Open in Editor… 

- Set current memory... 

Display 

The MB Tutor display may be set to show text entered in three font sizes. Depending on 
font size, it may show eight lines of text (four lines of text showing sign by sign what you 
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enter in braille and four lines of text converted by Grade 1 or Grade 2 rules, depending on 
what is set in Forward translation settings), four lines (two lines in braille and two text) or 
three lines (two lines in braille and one line of text). 

- Small fonts (8 lines) 

- Standard fonts (4 lines) 

- Big fonts (3 lines) 

Language 

If you want to change the device's language, go here and choose one from the list. 
A default braille table for that language is automatically selected when selecting a 
language. 

Page settings 

- Set left margin 
Set left margin to column 0 .. 12 

- Set right margin 
Set the right margin to column 0 .. 12 counted from the right edge of the paper 

- Set left margin to the head position 

- Set right margin to the head position 

- Reset left margin 
Set the left margin to column 0 

- Reset right margin 
Set the right margin to the last available for the loaded sheet of paper column  

- Set top margin 
Set the braille page Top Margin to line 0 .. 10 

- Set bottom margin 
Sets the Bottom Margin of the Braille page to line 0 .. 10 counted from the bottom 

edge of the page. 

- Reset top margin 
Set top margin to 0 lines 

- Reset bottom margin 
Set the bottom margin to 0 lines 

- Line spacing 
	 Sets Line spacing to 0.5 .. 3 in increments of 0.5 (default is 1.0) 
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Format 

- Centred emboss toggle 
This feature will make all braille lines centred between margins as set by the user. 

The embossing will occur after either a hard end of the line 
(Enter key) or when the unit decides the remaining text will be 
moved to the following line.  

- Right justified emboss (this option is a toggle) 
The embossing will occur after the line is closed by either a hard-end(Enter key) or 

when the unit decides the remaining text will be moved to the 
following line. 

Forward translation settings 
Forward translation means that you can send a regular text to MB Tutor, and it will convert 
it to braille with all contractions and other rules set by the user and emboss it on paper or 
store it as a braille file in memory. The text sources can be from a regular PC keyboard, a 
wirelessly connected mobile device, or a computer. 

- Emboss forward translation toggle  
Turns the forward translation to braille on and off 

- Basic translation toggle 
Once Forward Translation has been turned on (using the above menu option), you 

can select a mode called Basic Forward Translation, which 
helps work with very early braille learners and the whole of 
class activities. In Basic mode, each word is embossed after 
pressing the space key. This function automatically switches to 
uncontracted braille (grade 1). Default = OFF. 

Note: If Forward Basic translation is on, the MB Tutor will ignore "hyphens" and many 
other Forward translation commands and settings, including formatting commands. 

- Set forward translation grade 
Choose 1 or 2. 

- Literal mode toggle 
They are used for making columns and tables in braille. When it is on, each time 

you start a new print line, you will create a new line in braille. 

- Set hanging indent 
Creates a Hanging Indent. You can choose from 0, 1, 2, 3, 4, and 5 values.  

- Suppress blank lines 
Suppresses blank lines and adds a two-cell indent for new paragraphs. 

- Automatic indent set 
The current Braille column is stored when turned on, and subsequent braille lines 

are indented to that column. 

- Multiple space removal toggle 
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Replace all multiple spaces and tabs in the text with single spaces in the braille. 

- Fraction mode toggle (Nemeth) 
Causes text fractions to be translated to Nemeth braille fractions using a lower 

numeral sign for the denominator. A Nemeth mathematical 
separation sign is used after the braille fraction if it is 
immediately followed by punctuation. 

- Upper case input toggle 
Used when translating capitalised or upper case text. When on, prevents double 

capital sign before words all in upper case. 

- Hyphens at end of line toggle 
When on, it will break braille words at the end of a line. The default is off. 

- Lists on 
Turns lists (or tables) on. Thanks to this command, you can divide the text into two 

columns. 

- Lists off 
Turns lists (or tables) off. 

- Table with two equal width columns 
Allows the creation of simple lists or tables. This will produce a table of two 

columns, each 50% width. 

- Store forward settings 
It saves all settings you may have set with the above commands (or more manually 

entered commands) to the internal memory. 

- Restore forward settings 
Restores previously saved settings from the internal memory. 

- Restore default forward settings 
Restores default, set by the factory settings. If you think some settings are not 

correctly set - this is the fastest way to "return to normal." 

Back translation settings 
Back translation means that braille notation typed on MB Tutor or saved in a file will get 
converted into regular text and sent to an external device or printed (in black-print on an 
attached printer). 

- Set back translation grade 
Changing the braille Grade or Code Used.  Default = 2. 

- Automatic indent set 
Causes all subsequent print lines to indent to the current cursor position. 
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- Centre toggle 
It causes text to be centred between the left and right margins.  Default = off. 

- Justify toggle 
When on, it causes printed text to align with both margins.  This may cause extra 

spaces to be inserted into the text. Default = off. 
- Right align toggle 

When on, it causes printed text to align to the right margin.  When off, the text aligns 
to the left margin. The right alignment takes precedence over 
Justify.  Line length & horizontal margins may not be altered 
while the Right align is on, and tabs are converted to single 
spaces. Default = off.  

- Upper case toggle 
Locks output text into the upper case when on and returns to normal echo of 

keystrokes when off.  Default = Off. 

- Fraction mode toggle (Nemeth) 
Causes Nemeth braille fractions to be translated to text fractions using the slash 

character to separate numerator & denominator.  Requires the 
Mathematical braille separation sign (Dot 6) between the 
fraction & any subsequent punctuation. Default = Off. 

- Literal mode toggle 
Each new line in Braille will produce a new line in print. When off, a new line in 

Braille is ignored in the print copy (to avoid the print being 
broken). Default = off. 

- Multiple space removal toggle  
Remove hard spaces. It causes multiple spaces and tabs in your braille to be 

converted to single spaces and tabs in print. 

- Line spacing set 
Sets the printer line spacing to 1 .. 10.  Default = 1. 

- Store back translation settings 
It saves all settings you may have set with the above commands (or more manually 

entered commands) to the internal memory. 

- Restore back translation settings 
Restores previously saved settings from the internal memory. 

- Restore default back translation settings 
Restores default, set by the factory settings. If you think some settings are not 

correctly set - this is the fastest way to "return to normal". 

Common translation settings 
Some translation settings are universal - refer to both forward and back translation, hence 
Common translation settings. 

Mountbatten Brailler Tutor User Manual v. 1.1	 Page 24



- UEB mode toggle  

Use UEB Braille Code (Unified English Braille). Unified English Braille Code (UEBC, 
formerly UBC, now usually simply UEB) is an English language 
braille code standard developed to permit the uniform 
representation of the wide variety of literary and technical 
material in use in the English-speaking world today. 

Speech 

Go to this menu to decide how your Mountbatten Brailler Tutor speaks while you type, 
operate menus, or edit files. The Tutor can communicate in two ways: using recorded 
speech or synthetic speech. You will find options to change it in this menu. While you use 
synthetic speech, whatever you type can be read as letters, words, or complete sentences. 
This feature is called "echo". In this menu, you can set how Tutor echoes what you type 
and what else it will read. 

- Echo options 

- Letter echo 
Each character you are going to type in will be spoken. Works both for recorded 

and synthetic speech. Default ON. 

- Word echo 
Each word you type in will be spoken after entering a space, punctuation, or new 

line after the word. It works for synthetic speech only. Default = 
ON. 

- Line echo 
Each line you type in will be spoken after entering a new line character, or MB Tutor 

will perform an automatic new line. It works for synthetic 
speech only. Default = ON. 

- Sentence echo 
Each sentence you type in will be spoken after entering sentence punctuation (like 

a period, exclamation mark, question mark, etc.). Works for 
synthetic speech only. Default = OFF. 

- Synthetic speech 
When using natural-sounding synthetic speech that reads letters and words or 

complete text, you must set this on. This feature is ON by 
default but is available only after a minute from turning your 
Mountbatten Brailler Tutor on - the synthetic speech engine 
needs to start first. 

- Recorded speech 
This kind of speech is well suited to the menus and messages the Tutor expresses 

but will not read words or sentences you type. This kind of 
speech works immediately after you start your Tutor. Before the 
synthetic speech machine starts, it will speak even if it is off (for 
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the first minute or so after you start the unit). 

- No speech 
Nothing will speak - neither menus, typed characters of words, nor messages.  

- Speak prompts only 
Only menus and messages will be announced with voice. 

- Speak all keys 
This command makes all keys spoken either with synthetic or recorded speech, 

depending on which was previously chosen. 

Keyboard 

- One hand mode 
This feature serves those users who suffer from a condition that prevents them from 

brailling with two hands. It is described above - in the One hand 
keyboard mode section. 

Emboss 

- Emboss ON/OFF toggle 
Turn the embossing function off and on. Default = ON. 

- Word wrap toggle 
Word wrap. The word is not embossed when word wrap is ON until the space key is 

pressed. If the word cannot fit on the line, it is moved to the 
beginning of the following line. Thus, any word is embossed 
only after it is completed for the machine to determine whether 
it fits a line. Default = OFF. 

- Emboss commands 
Emboss command names as they are entered on the keyboard or their equivalents, 

even if selected in a menu. It can help track mistakes. Default = 
OFF. 

- Force new page 
This command ejects a page of paper loaded into the machine. 

- Graphics mode toggle 
Graphics mode.  In graphics mode, the space between the dots is reduced, giving 

the appearance and feel of lines instead of dots. There is much scope for 
creativity, and experimenting with braille graphics can reinforce spatial 
awareness of the page and finger sensitivity to braille dots. Default = OFF. 

- Multi strike emboss 
Multi-strike feature. Set strikes per dot to 1 .. 4. Useful for brailling on heavy 

materials such as plastic braille tags. Default = 1 
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- Right margin bell toggle 
Right margin bell. The bell rings five positions from the right-hand margin. Default = 

on. 

- Set end of page bell line 
Set the page bottom warning bell to ring "n" lines before the end of the page.  

Calendar  
This menu serves to connect to a Google Calendar online and edit calendar entries. As a 
prerequisite, the MB Tutor needs to be connected to the Internet over a Wi-fi connection.  

Login to your Google Calendar to make it available. 

Games 

This menu will show all games that are installed on your machine. Currently, we provide 
two games with a brand new Tutor - you can update your device with more games as they 
are released. The pre-installed games include: 

- Keyboard Master - lets the user learn how to write and read braille, braille letters, and 
braille typing skills. 

- Letter Relay Race - fun to play along with the device with other persons, allows for 
vocabulary development and improves spelling skills. 

See the Games section for more details. 

Braille tables 

This menu displays a list of Braille tables available for use. Please choose one with the 
Command key. 

System 

In this menu, you will find functions essential for the device, like turning it off or connecting 
it to the Internet.  

- Simplified Mode 
This option toggles the simplified and advanced modes.  In simplified mode, the 

menu consists of the most valuable four items, and all the other 
advanced options are hidden under the More Options 
submenu. 

- Close Mountbatten 
This option will turn the device off. Stopping all internal processes will last for a 

better part of a minute. You will hear beeps while the Tutor 
switches off. As an equivalent to this command, you may press 
and keep pressing for 5 seconds the on/off switch until you 
hear "bye-bye" from the Tutor. 

- Emboss version information 
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This will emboss all essential information on the unit - including its serial number, 
model, memory, etc.  

- Date and time settings 
This menu serves to read and set the date and time of the device.  

- Remote control 
Here, you may decide if remote control may be used. It is meant for future use. 

- WiFi settings 
Here, you may set a wireless network password to connect your unit to the Internet. 

Please see the "Connecting to the Internet" Section. 

- Save current settings 
It saves all settings that you may have set to the internal memory. 

- Restore saved settings 
Restores previously saved to internal memory settings. 

- Restore default settings 
Restores all settings to factory default. 

- Developers 
It is meant for developers only; please don’t use this menu. 

- Update device 
If you have obtained an update file set on a USB drive, place it in the upper USB 

socket on the right side of your unit and select this menu 
option. 
The system will update your unit and restart. The update may 
include various parts of the system (like the audio module, 
display module, etc.) and may take several minutes (in the 
case of an audio update, even up to an hour). See Updating 
your Mountbatten Brailler Tutor Section below. 

- Update advanced module 
If you have obtained an update file set on a USB drive, place it in the upper USB 

socket on the left side of your unit and select this menu option. 
You will be presented with a choice to use the Internet to 
update the advanced features. Your device must be connected 
to a local network with Internet access.  
The update (either from USB or the Internet) may take several 
minutes. See Updating your Mountbatten Brailler Tutor Section 
below. 

- Device information 
Displays basic information on the unit - including its serial number, firmware and 

bootloader version. 
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- Reset to factory settings 
Resets the unit and erases all data from the device - a good thing to do when you 

remit the device to a new owner. 
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Games 
Mountbatten Brailler Tutor comes with a couple of pre-loaded games. Both games address 
braille writing: 

Keyboard Master 
This game has four modes. It suits beginners and advanced braillists to test and improve 
fast writing.  Go to the game settings in the game menu to choose the mode. 

You will hear a help message explaining your task in any mode. This message will expire 
after you listen to it once or twice. You can press TAB to hear it again. You can also go to 
settings and switch help messages off. 

Explorer mode 

If you are still getting familiar with the braille keyboard, please start with Explorer mode. 
This mode is for getting you to know the keyboard. Press any key, and the program will tell 
you what the key does.  Try Perkins (braille dot) keys and any other keys on the MB Tutor 
keyboard. To exit this mode, double-tap any key.  

Learning mode 

This mode is for practising your writing skills. You must write specific dots (e.g., dot 3) or 
those corresponding to a letter. If you make a mistake, you will hear what you’ve just 
pressed, and the request will be repeated. It will get skipped if you make three mistakes in 
reply to the same request. 

Character contest mode 

This mode will test your typing skills. Your task is to press keys that correspond to a 
requested letter. If you type the wrong letter, the game continues - no information about 
pressed keys will be spoken. 

Word contest mode 

Word contest mode is suitable for practising your brailling skills. You will be asked to write 
words that contain letters from a letter group.  

A letter group is a concept based on the fact that the first ten letters of the alphabet, a–j, 
use the upper four dot positions. The following ten letters, k–t, are identical to a–j, 
respectively, apart from the addition of a dot at position 3. There are three groups like this, 
plus punctuation, etc.  

To choose a group you want to use, please go to Settings. 

While you play, whenever you press the tab key, the program will tell you what you have 
typed so far. Press enter if you are unsure what was requested or how to spell the given 
word. The program will spell it for you. 

Please use backspace to erase the last letter whenever you make a mistake. You are 
allowed to use the backspace key one time in each game. 
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Letter Relay Race 
This game is fun to play with the device or with other people. The game aims to guess and 
write (in Braille) words with the first letter equal to the last of the words entered by the 
preceding player. Mountbatten Brailler Tutor may be one of many players (not only when 
you play one-to-Tutor), and it checks the correctness of whatever word is entered by any 
of the players. If the word is correct, you will receive several points in proportion to the 
length of the word. You will get a penalty for misspelt words. The game lasts several 
rounds. The player who earned the most points wins.  

If you didn't hear the last word, you might ask to repeat it by pressing Spacebar.  

Good luck.  

Calendar 
Mountbatten Brailler Tutor has a Calendar functionality that allows synchronisation with 
Google Calendar. A student learning braille can learn how to schedule his day or week, 
share the schedule with classmates and emboss his plan for a week.  

To synchronise with Google Calendar, you need to connect MB Tutor with the Internet over 
Wi-Fi and log in to Google. 
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Advanced features of Mountbatten Brailler Tutor. 
Mountbatten Brailler Tutor may be controlled using the menu (a short press of the 
middle key of the four-way manipulator opens the menu) or by entering commands 
(the command line begins after a long press of the manipulator's middle key). This 
chapter will explain how the commands work and use the second text column to 
show the corresponding command. You will notice that some advanced commands 
have no menu equivalent. 

Braille with speech 
The Mountbatten offers many advantages for braille students and provides excellent 
flexibility to meet their individual needs. However, it is essential to remember that speech 
output is provided only as a re-enforcement and instant feedback to develop braille 
reading and writing skills.  Listening to the speech feedback should not be an alternative to 
reading with fingers. Speech output is designed to augment the development of tactile 
reading skills, not be a substitute for them. 

Ensure you know the options available for the speech output and how important it is to 
match it to the student's needs.  Speech can promote independence by informing students 
of everything happening to their braille writer. Speech can also help a student gain 
confidence and increase braille writing speeds. The use of speech during early braille 
instruction will also assist in skill development relating to a wide range of other 
technologies that they will encounter. 

But the bottom line is that Mountbatten is a braille writer. Its primary function is to develop 
braille reading and writing skills, and speech output is secondary. 

Speech control 
Speech control functions may be set using Speech menu items or by commands.  
There are many options for using speech to learn to write and read Braille.  

The speech mode will revert to the default after turning the unit off and on 
again. 

Menu item Command Description
Speech/Synthetic 
Speech

SPK S Turns on Synthetic Speech. Useful for speaking all 
contractions and unlimited vocabulary.

Speech/Recorded 
Speech

SPK R Selects recorded speech. 

Speech/Speak All 
Keys

SPK A Speaks all keyboard keys, functions and commands. 
With every key stroke being spoken the user receives 
immediate feedback every step of the way. As less 
speech is required one of the following options can be 
used.

Speech/Speak 
Prompts only

SPK C Speaks errors & prompts only. No Braille dot keys

Speech/Speak 
dots 	 	

SPK D Speaks only braille dot keys. No function keys.

No Speech SPK N No speech. The machine will not produce any speech. 
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BRAILLE WRITING 
Formatting your Braille 
The ability to format braille printouts is a great advantage of an electronic brailler. To judge 
how difficult it would be without the electronic control, think of how to make it by hand to 
centre your 12-letter title on a braille page manually: count the line width, subtract 12 (the 
length of your title) and divide by two - the outcome of this is the number of spaces to be 
entered at the beginning of a line to keep the title centred. It's doable - but quite 
complicated.  
The following formatting commands will make formatting an easy and fun task. 

Braille writing commands 

Menu item Command Description
Position of Braille on the Paper

Format/Centred 
emboss

CE Centre text. The text to be centred will only be embossed 
after the new line key is pressed. Default = off. Toggle. 

Format/Right 
justified emboss

RA Right adjust braille (the braille will be printed from the 
right hand margin). Default = off. Toggle

Margins

Page settings/
Reset left margin

LM Set the left hand margin to 0 

Page settings/Set 
left margin to head 
position

LMH Set the left margin to embossing head position.

Page settings/Set 
left margin

LM n Set the left margin to column ‘n’

Page settings/Set 
right margin

RM Set the right hand margin to 0

Page settings/Set 
right margin to 
head position

RMH Set the right margin to embossing head position.

Page settings/Set 
right margin

RM n Set the right margin to column ‘n’

Page settings/Set 
top margin

TM n Set braille page top margin. n = number of lines.

Page settings/Set 
bottom margin

BM n Sets the bottom margin of braille page. n = number of 
lines for bottom margin.

Tab Settings

TSH Set tab at the position of the embossing head.

TC Clear all tab settings.

Line Spacing

Page settings/Line 
spacing

LS n[m] Line spacing. Default = 1. If you wanted line spacing of 
1.5 lines the command would be LS 1.5

Menu item Command Description
Emboss/Emboss 
ON/OFF

EM Turn the embossing function off and on. Default = on. 
Toggle
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Saving braille files in memory 
The following formatting commands apply to the currently selected memory - External on a 
USB stick or the unit's internal memory. 
In the following commands, [filename] means a name of your choosing up to 16 
characters.  

	  

MAN Choose between  Manual new line & auto new line. A 
manual new line means you have to press the New Line 
key at the end of each line. Auto New Line means the MB 
will automatically go to the start of the new line.  Default 
= Auto. Toggle

Emboss/Multi 
strike emboss

MS [n] Multi-strike feature. Set strikes per dot to "n". Useful for 
brailling on heavy materials such as plastic braille labels. 
n = 1 to 4.  Default = 1

Emboss/Force 
new page

NP Force a New (braille) Page. Your current page will be 
ejected.

PN [n] Begin page numbering starting at value of "n". Each time 
you put paper in your MB the page number will be printed 
in the top right hand corner.

Emboss/Set end 
of page bell line

PBELL [n] Set page bottom warning bell to ring "n" lines before the 
end of the page.

Emboss/Right 
margin bell

RMBELL Right margin bell. The bell rings 5 positions from the right 
hand margin. Default = on. Toggle

Emboss/Emboss 
commands 

SHOW Emboss commands as they are entered on the keyboard. 
Can help track mistakes. Default = Off. Toggle

Emboss/Word 
wrap

WW Word wrap. When word wrap is on, the word is not 
embossed till the Space Key is pressed. If the word 
cannot fit on the line, it is moved to the beginning of the 
next line. Default = Off. Toggle

COR Correction mode. Some teachers may want to turn the 
erase and correction feature off during an exam! Default 
= on. Toggle

Menu item Command Description

Menu item Command Description
File/Create new 
file

BEGIN [filename] Start a file - opens a new file, called "filename".

File/Append to a 
file

APPEND 
[filename]

Change the file - append more information to "filename".

File/Close current 
file

END Close a file - close an open file.

DIR Find out which files you have stored in memory - 
embosses all filenames and their sizes

RENAME 
filename1 
filename2

Rename "filename1" to "filename2".

File/Emboss... PR [filename] Print the file named "filename". Uses current settings.	

MPR y [filename] Print "y" multiple copies of the file named "filename".

File/Open in 
Editor...

Opens a file in the internal editor - see Editor chapter.

File/Set current 
memory...

This menu option will let you choose between Internal or 
USB memory pools.
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Miscellaneous commands 

	 	 	 	  
	 ALT n	 	 Enables your MB to accept ASCII characters above 128. ‘n’ can be 

any ASCII value 
	  

Braille translation 
MB Tutor can translate in either direction, and we use the following conventions to 
describe braille translation. 
	 	 	 	 	 	 	 	  
Back translation -	 	 Braille                         Print  

Converting Braille that you type on the MB keyboard into 
regular text. 

Forward translation - 	 Print                            Braille 
Converting regular text (from any source) into Braille.  

	 	 	 	  
Braille code - 	 	 The Braille code installed in your machine is appropriate for 

your country. The MB can also contain the Braille codes for 
other languages. 

Braille exception table  
Some of the most advanced functionality below is only available from typed-in commands.  
The MB lets you create exceptions to the braille rules. The exception table allows you to 
change the code to suit your needs. For example, consider introducing contractions 
gradually or making abbreviations. Up to 128 entries are allowed. 

The braille exception table is active in both forward and back translation. The commands 
and conditions for creating exceptions to the braille rules are as follows; 
	 	

Menu item Command Description
System/Simplified 
Mode 

Switches simplified mode on/off. A toggle.

System/Close 
Mountbatten

Turn the device off.

System/Emboss 
version 
information

VER Embosses  basic information on the unit - including its 
serial number, firmware and bootloader version.

System/WiFi 
settings

Choose a wireless network and set a network password.

System/Save 
current settings

SAVE Saves all settings that you may have set to the internal 
memory.

System/Restore 
saved settings

Restore previously saved to internal memory settings.

System/Update 
device

Update the system from a USB memory stick.

System/Update 
advanced module

Update the advanced module of MB Tutor - either from a 
file on USB or through the Internet connection.

System/Device 
information

Displays  basic information on the unit - including its 
serial number, firmware and bootloader version.

System/Reset to 
factory settings

Resets the unit and erases all data from the device - a 
good thing to do when you remit the device to a new 
owner
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Forward translation - converting print to braille 

Forward translation means that you can send a regular text to the MB, and it will convert it 
to braille and emboss it on paper or store it as a braille file in memory. The text sources 
can be from a regular PC keyboard, a portable note-taker, or a computer. 

The most common way of using Forward translation on the MB is via a PC keyboard. In 
this way, anyone can write information on the PC keyboard and have it automatically 
converted to braille. This potent tool in an educational setting allows everyone to 
participate in braille. It is also handy in various settings for leaving braille notes and 
producing a wide range of other brailled materials (like birthday cards) that often do not get 
brailled. 

Using a PC (QWERTY) keyboard 
1) Connect the PC keyboard to the USB port on the right of your MB Tutor,  
2) Enter the command FE to turn on Forward Translation (in English versions, the 
default is Grade 2) 

Now, start to type on the PC keyboard. The MB will store your information in a buffer and 
emboss it every 80 characters, or you can empty the buffer by pressing the Enter Key 
twice. To change the Braille grade, use FGR 1 for Grade 1 or FGR 2 for Grade 2.  Many 
keys on the PC keyboard have the same function as keys on the MB. 

Menu item Command Description
ETA text braille 
position

Text Braille position. Adds an entry to the exception table 
where "text" is the text to be changed; "braille" is the 
braille which will be substituted; position is one or a 
combination of the five position indicators given below: 
b - allowed at the beginning of a word 
m - allowed in the middle of a word 
e - allowed at the end of a word 
a - allowed anywhere 
s - allowed only by itself (except adjacent to punctuation)

ETC Clears the exception table

ETD  text Deletes an entry from the exception table where "text" is 
the text to be changed

ETU Turns the exception table off or on.  Default = on. Toggle

Keys on the PC Keyboard Keys on the MB Keyboard

Windows key Command 

Enter New Line 

Down Arrow Four-way manipulator down

Up Arrow Four-way manipulator up

Left Arrow Four-way manipulator lleft

Right Arrow Four-way manipulator right

Space Space
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Here is a list of forward translation commands: 

Backspace Backspace

Menu item Command Description
Forward translation settings/
Emboss forward translation toggle

FE Forward, translate, and emboss. Toggle

Forward translation settings/Basic 
translation toggle

FB In basic mode, each word is embossed 
after the space key is pressed. This 
function automatically switches to 
uncontracted Grade 1 braille. Toggle

FM filename Forward, translate, and send to ‘filename’ 
in memory (turns embosser off).

FM Append Forward, translate, and append to 
previously stored file with the name 
‘filename’.

FM END Closes file and turns forward translation 
off. And turns embossing back on.

Change braille Grade or Code

Forward translation settings/Set 
forward translation grade

FGR grade Select the translation Grade, where 
‘grade’ may be 1 or 2.  Default = 2.

FLN language Change the translation Rules language

FFC language Foreign character selection. This enables 
the insertion of foreign or accented 
characters into your text (without 
changing the translation rules where 
[language] can be one of the following 
codes: OZ=Australian ITL=Italian  
DAN=Danish   NOR=Norwegian 
UK=English SP=Spanish 	 FR=French 
SWE=Swedish GER=German  
USA=United States GRK=Greek  
DUT=Dutch 	 FIN=Finnish 
POR=Portuguese)

Formatting Your braille

Forward translation settings/Literal 
mode toggle

FLIT Literal mode. Used for making columns 
and tables in braille. When it is on, each 
time you start a new line in print, you will 
start a new line in braille. Default = off. 
Toggle.

Forward translation settings/Set 
hanging indent

FLIT n Creates a hanging indent. The variable 
"n" gives the number of indented spaces 
and can be 0, 1, 2, 3, 4, 5.

Forward translation settings/
Suppress blank lines

FLIT S It suppresses blank lines and adds a two-
cell indent for new aragraphs. Default = 
on

Italics

FIT When on, it causes the subsequent text to 
be italicised in braille. Default = off. 
Toggle

Hyphens

Forward translation settings/
Hyphens at end of line toggle

FHYP When on, it will break Braille words at the 
end of the line. Default = off. Toggle
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Lists / Tables 	  
These commands simplify building lists or tables, such as spelling lists, tables of contents, 
etc. The command can create two or three columns using default settings or user-selected 
settings. Each column is specified as a percentage of the braille line length. 

Automatic Indent

Forward translation settings/
Automatic indent set

FIN When FIN is turned on, the current braille 
column is stored, and subsequent braille 
lines are indented to that column. Default 
= off. Toggle

Multiple Space Removal

Forward translation settings/
Multiple space removal toggle

FSH Replaces all multiple spaces and tabs in 
the text with single spaces in the braille. 
Default = on. Toggle

Fraction Mode

Forward translation settings/
Fraction mode toggle

FFR Causes text fractions to be translated to 
braille fractions using lower numeral sign 
for the denominator. A mathematical 
separation sign is used after the braille 
fraction if it is immediately followed by 
punctuation. Default = off. Toggle

Upper Case

Forward translation settings/Upper 
case input toggle

FCL Used when translating capitalised or 
upper case text. When on, prevents 
double capital sign before words all in 
upper case. Default = off. Toggle

New Page

Emboss/Force new page NP Forces a new braille page.

New Paragraph

FPA Forces a new braille paragraph. Used for 
flagging a new paragraph that coincides 
with the top of a text page.

Menu item Command Description

Menu item Command Description
Forward translation settings/Lists 
on 
Forward translation settings/Lists 
off

FLIST Allows the creation of simple lists or tables. 
This will produce a table of three columns,  
of 40%, 40% and 20% width. For example: 
If your Braille page is 40 cells wide then 
the default will give three columns, each of 
cell widths 16, 16 and 8. Default = Off. 
Toggle
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Saving Your Preferred Settings 

	  

Back translation - converting braille to print  

To produce a print copy simultaneously with a braille copy, we have to perform a back-
translation job - going from braille to print. The printout will be directed to a connected 
Bluetooth mobile device or a USB printer. 

FLIST n1 n2 This command allows you to specify your 
own column widths as a percentage of the 
line length. The values allocated to n1 and 
n2 will determine if you want two or three 
columns. If the values of n1 and n2 add up 
to exactly 100%, then you will get two 
columns with widths in the proportions 
specified. If they do not add up to 100%, 
then you get three columns, of which the 
third column is the remainder. For three 
columns, the third column cannot be 
greater than 90% or less than 10%. 
You cannot have blank columns except for 
the first column, and columns two and 
three are always right justified.

Menu item Command Description

Menu item Command Description
Forward translation settings/
Store forward settings

SAVE FT Saves all current forward translation 
settings, including braille Grade, language, 
and output settings.

Forward translation settings/
Restore default forward settings

STD FT Restores all default forward translation 
settings. Does not interfere with stored 
settings.

Forward translation settings/
Restore forward settings

RESTORE FT Restores all stored forward translation 
settings.

Menu item Command Description
Turning back translation on

BP Back translate to USB printer port (the one 
on the left of MB Tutor). Toggle. 
Use this when you have a printer 
connected to the USB port.

BS1 Back translate to Bluetooth-connected 
device. Toggle.

Changing the braille Grade or code used

Back translation settings/Set 
back translation Grade

BGR [grade] Translation Grade, where "grade" may be 
1 or 2.  Default = 2.
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BFC [language] Foreign character selection, where 
[language] can be one of the following 
codes: OZ=Australian,  ITL=Italian,   
DAN=Danish,    NOR=Norwegian,  
UK=English,  SP=Spanish,  	 FR=French,  
SWE=Swedish,  GER=German,   
USA=United States,  GRK=Greek,   
DUT=Dutch FIN=Finnish,  
POR=Portuguese 
Using this command, you can insert 
foreign or accented characters into your 
text.

Formatting Your Print Page

Back translation settings/
Automatic indent set

BIN This causes all subsequent lines to be 
indented to the current cursor position.  
Default = Off. Toggle

Back translation settings/Centre 
toggle

BCE When on, it causes text to be centred 
between left and right margins.  Default = 
off. Toggle

Columns and tables

Back translation settings/Literal 
mode toggle

BLIT Literal mode. When on, each new line in 
Braille will produce a new line in print. 
When off, a new line in braille is ignored in 
the print copy (to avoid the print being 
broken). Default = off. Toggle

BSH Remove hard spaces. This causes 
multiple spaces and tabs in your braille to 
be converted to single spaces and tabs in 
the print. Default = Off. Toggle

Margins, line length, paper size Note: 	 	 	
When setting margins and line length, an 
error will result if the line length less the 
margins does not leave at least 10 
printable characters across the page.

BLM [n] Sets the width of the left margin to ‘n’ 
blank spaces from the left-hand edge of 
the paper.  The maximum value of ‘n’ is 
30. Default = 8.

BRM [n] Sets the width of right margin to ‘n’ blank 
spaces from the right-hand edge of the 
paper.  The maximum value of ‘n’ is 30. 
Default = 8.

BTM [n] Sets a margin of ‘n’ blank lines at the top 
of the page before printing begins.  The 
top margin may not exceed the form 
length less the page length.  Default = 3.

BLL [n] Sets the width of the print line, including 
margins, to ‘n’ characters, at 10 characters 
per inch. The maximum value of ‘n’ is 132.  
Default = 80.

BFL [n] Sets the page length in "n" lines, at 6 lines 
to the vertical inch.  The maximum value 
of "n" is 100.  Default = 66.

BPL [n] Sets the number of printed lines on the 
page to "n".  The page length may not 
exceed the form length.  Default = 60.

Menu item Command Description
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Adding braille rules 
Adding extra rules to the MB Tutor with the exception table 
Your MB has the flexibility to make exceptions to the standard braille rules you are 
using, to use the shortcuts or abbreviations of your choice, or to introduce groups 
of contractions. 

The braille exception table is active in both forward and back translation, and you 
can use the commands and make additions to your exception table in either Learn 
or Advanced mode. 

You can add up to 128 entries to the Exception table. 

Back translation settings/Upper 
case toggle

BCL Locks output text into upper case when on 
and returns to normal echo of keystrokes 
when off.  Default = Off. Toggle

Back translation settings/Fraction 
mode toggle

BFR Causes Braille fractions to be translated to 
text fractions using the slash character to 
separate numerator & denominator.  
Requires use of mathematical braille 
separation sign (dot 6 in English) between 
the fraction & any subsequent punctuation. 
Default = Off. Toggle

BTBC Clears all current tab stops

BTBA [n] Sets an extra tab stop at position "n".

Back translation settings/Line 
spacing set

BLS [n] Sets the printer line spacing to "n", ranging 
from 1 to 10.  Default = 1.

Back translation settings/Justify 
toggle

BPJ When on, it causes printed text to align 
with both margins.  This may cause extra 
spaces to be inserted into text. Default = 
off. Toggle

Back translation settings/Right 
align toggle

BRA When on, it causes printed text to align to 
the right margin.  When off, the text aligns 
to the left margin. BRA takes precedence 
over BPJ.  Line length & horizontal 
margins may not be altered while BRA is 
on and tabs are converted to single 
spaces. Default = off. Toggle

BPN [n] [p] Turns page numbering on or off at the 
desired position ‘p’ with a value of ‘n’. Max. 
value of ‘n’ is 1000, and accepted position 
codes are: TL - Top left; BC - Bottom 
centre; TC - Top centre; BR - Bottom right; 
TR - Top right; OFF - Turn off; BL - Bottom 
left; ON - Turn on page numbering

BPNT [braille] Creates a text string to be printed with the 
page number, where "braille" is the text to 
be printed.   
Note: To position text and turn numbering 
on and off, use the BPN command, as 
given above. Max. length of the text is 15 
characters, and no punctuation is allowed.

Menu item Command Description
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Braille exception table commands 
eta text braille position 

This is the main command to add an entry to the exception table. 

text is the text to be changed; 

braille is the braille that will be substituted; 

position is any one or a combination of the five position indicators given 
below: 

a - allowed anywhere 

b - allowed only at the beginning of a word 

e - allowed only at the end of a word 

m - allowed only in the middle of a word 

s - allowed only by itself (except adjacent to spaces and/or punctuation). 

etc	 Clears the exception table. 

etd [text]	 Deletes an entry from the exception table, where [text] is the 
text part of the entry. 

etu	 Turns the exception table off or on. This is a toggle command, and 
the default status is on. 

Exception Table Examples 

eta hello hl s 

This command would add a rule to cause the word "hello" to be translated to the 
abbreviation "hl", but only if "hello" is by itself. It could be surrounded by spaces or 
punctuation but could not be contained within a word. 

As another example, if you wish "help" to be translated to "hp" at the beginning and 
end of a word but not the middle, the command would look like this: 

eta help hp be 
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Editor 
The editor lets you create and edit text files within the MB memory. It does this in a place 
called the editor buffer. Once in the editor, text can be entered, inserted, and deleted. You 
can also search for and replace text, copy,  move and paste the text you choose. 

Getting started 
Entering the Editor 

EDIT (filename)	 where [filename] is the name of the file you have stored in 
memory (or the name of the new file if you are starting a new 
one). If the filename is new, the  MB will say "file not found", 
"creating new file", and then speak the filename. The editor is 
active if no filename is given, but the file will have no filename.  
You will be prompted for a filename when exiting.  
For whatever reason, if there is previous unsaved data in the 
buffer, the MB will say: "Unsaved file in editor"  "Please clear or 
save file". You must either clear the editor buffer (by pressing 
the character "c") or save the file (by pressing the character 
"s"). After either clearing or saving, you can read in another file. 

Enter+Q	 	 	 Exit the editor 
You will be prompted: "Save File First". Answering Y will save 
the editor buffer as a file, with the filename given, before 
returning to normal MB mode. Answering N will not save any 
data and return to normal MB mode.  

Help 
Enter+H	 	 Help Menu. Default Off. Toggle 

Moving around within a file 
Cursor commands 

To move around the file, we use cursor commands. These are known as chorded 
commands. The notation sp + dot 3 means you have to press the space key and dot 3 
simultaneously.  

SP + DOT 3	 	 Move to the previous character and speak it 
SP + DOT 2	 	 Move to the previous word and speak it 
SP + DOT 1	 	 Move to the previous line and speak it 
SP + DOTS 13	 Move cursor to the top of the previous page 
SP + DOTS 123	 Move cursor to start of the file 
SP + DOTS 36	 Speak current character 

Pressing twice will give phonetic equivalent or dot equivalent 
for contractions or non-letters 

SP + DOTS 25	 Speak current word 
SP + DOTS 14	 Speak current line 

SP + DOT 6	 	 Move to the next character and speak it 
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SP + DOT 5	 	 Move to the next word and speak it 
SP + DOT 4	 	 Move to the following line and speak it 
SP + DOTS 46	 Move the cursor to the top of the next page 
SP + DOTS 456	 Move the cursor to the end of the file. 

Note: 		 If you attempt to move past the start or end of the file, the MB will say 
"top of file" or "end of file". The new message will override the old if 
the MB speaks as you enter another cursor command.  When new 
text is entered, the cursor automatically returns to the text entry 
position. 

Editor chorded  commands 

Before moving onto the Menu Commands, there are other chorded commands for you to 
try. 

SP + T	 TAB. Inserts a TAB at the cursor position in your file. 
SP + P	 HARD PAGE BREAK. Forces a hard page break at the cursor position 

in your file. 
Enter + I	 INSERT/OVERWRITE MODE. Changes the editor between the insert 

and overwrite mode. 
	 	 	 The default is Insert. Toggle 

Move the cursor to the desired position in insert mode and write the text inserted. 
Then, move the cursor to a new position using one of the movement chorded 
commands. To delete inserted text before moving, press the Command key. If the 
MB is in Overwrite mode, the text will be overwritten until the following command: 
hard carriage return or hard page break.  

	 Enter+C	 CHANGING THE CASE OF TEXT. Text can be stored in upper case, 
lower case, or with no case conversion. Letters entered via the Braille 
keyboard are usually treated as upper case unless changed by this 
option. Case conversion is only helpful if you use a PC keyboard for 
input and want case conversion to be carried out by something other 
than the MB. In this instance, the Shift or CapsLock key on the PC 
keyboard would enter the upper and lower case.  

Enter+W	 WHERE AM I?: This command gives the file's filename and current 
position (page number, line number, and column number). If you are 
on a menu, it gives the menu's name. 

SP+R		 SPEAK REST OF FILE Speak the rest of a file without moving the 
cursor using the command: 

	  
SP+Z	 	 SILENCE COMMAND a universal silence command can be used 

anytime. 

Keyboard commands 

The following MB keys are used for immediate editor commands. 
Enter	 	 Enter key is treated as a (hard) carriage return. 
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BS	 	 Backspace key is the same as the Read Last Character command (sp 
+ dot3), except when you enter text in response to a prompt, e.g. 
when asked for a filename, it will act as an actual BackSpace. 

CMD	 	 Command key will cancel any operation currently in progress. 

Menu commands 

For editing, the MB has a range of commands organised into five separate menus 
according to their tasks. These are: 

File menu 	   for file maintenance (selecting or saving files, renaming files, etc.) 
Search menu enables you to search and/or replace selected text 
Block menu	  allows you to select, copy, move, or delete sections of text 
Delete menu  for deleting or restoring characters, words, lines, or  page 
Edit menu	   provides further editing functions	  

Note:	 When asked to answer a Yes or No question, only enter Y or N. Any other answer is 
ignored. 

Exiting the menus and the Editor  
SP+E	 	 This is used for all of the menus described. When you exit the menu, 

you will return to the Editor. 
Enter+Q	 Exit the Editor 

File menu 
This menu enables file operations such as reading, saving, re-formatting, etc. 

Enter+F	 Entering the File Menu: The File menu has the following options: 
O	 	 OPEN A FILE AND MOVE IT TO  THE EDITOR 
R	 	 RENAME THE FILE This command changes the file's name in the 

editor. 
C	 	 CLEAR THE EDITOR WORKSPACE If the current Editor file has been 

changed and not saved, you will be asked to save this file before 
clearing the workspace. 

D	 	 GIVE DIRECTORY LISTING The directory listing announces the 
names of files one by one. Once you have entered the command, you 
are placed at the top of the file listing with the following supplementary 
commands available: 

	 	 	 A  	 Speak the previous filename in the file listing. Moves the file 
cursor up. 

	 	 	 C  	 Speak the current filename in the file listing 
DOT 4  Speak the following filename in the file listing. Moves the file 
cursor down. 
O  	 Open a file, at the current "file cursor" position, into the editor. If 
an existing file in the Editor has not yet been saved, you will be asked 
if you wish to save the current file before loading up the next one. 
D	 Delete the file at the current "file cursor" position. 
F 	 Give remaining  space in the editor buffer 

P	 	 PROTECT / UNPROTECT THE FILE  Default Unprotected. Toggle. 
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While in this mode, the MB will say "File protected" whenever you try 
to enter any characters in the document, either in insert or overwrite 
mode. 

F	 	 RE-FORMAT THE FILE Although this is done automatically when the 
file is saved or when text is moved around, there may be a time when 
you would like the file to be reformatted (perhaps before listening to a 
final version). 

S	 	 SAVE THE CURRENT EDITOR FILE When you use this command, 
the file you are working on is reformatted to fit within the current 
margins and saved. However, the following conditions apply: 

-If no filename has been assigned to this file, you are asked to 
enter one. 
-If the file already exists, you are asked if you want to 
overwrite it. If you answer N, then you are returned to the 
Editor. 
-If there is not enough room in memory to save the whole 
file, you will be asked if you wish to save the file regardless, in 
which case it will be cut short to fit. Answering N will return you 
to the Editor. 
-If necessary, to make more room, exit the Editor and use the 
standard MB commands to clear out any old files. Then, enter 
and re-save the Editor file. 

SP + E 	 	 EXIT THE MENU  

Edit menu 
The Edit menu has commands for finding out how much space is left in the Editor, the size 
of the file you are working on or finding a page number in your file. It also allows you to 
embed formatting commands into the file or Braille grade commands to change the grade 
in the entire file or a fragment. 

Enter+E	 Enter the Edit Menu: The Edit menu has the following options: 
	 	 S	 SIZE OF CURRENT FILE 
	 	 R	 REMAINING WORKSPACE 
	 	 W	 WHERE AM I? Gives current page, line, and cursor 

position. 
	 	 F	 FORM NEW PARAGRAPHS This command can join 

broken lines (as will happen if a file sent from a computer has 
different margin settings to the MB). All existing paragraph 
formatting is maintained. 

	 	 J	 JOIN CURRENT AND NEXT PARAGRAPH This command can 
only be entered on the last line of the current paragraph. 

	 	 D	 DELETE HARD PAGE BREAKS IN FILE 
	 G	 GO TO a selected page number. The Editor will say 

"Enter page number". You can enter a page number in Text or 
Braille format. The NEWLINE key must follow the number. If 
the page number is valid, the editor cursor is moved to the first 
character of the page number requested.  If the number 
entered exceeds the number of pages in the file,  the message 
"Invalid input" is given.  
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	 	 C	 ENTER MOUNTBATTEN COMMAND If you want to enter a 
standard MB command (e.g., for formatting) in your file, you 
need to use this command. When you press C, the MB will say 
"Enter MB Command". Enter the command as you would 
usually, then press the "Newline" key to terminate the 
command. Do not press the "Enter" key, as it has no meaning 
within the editor. After pressing "Newline", the MB will say 
"Please Wait" and then "Finished" when the command has 
been inserted. 

	 	 T	 TAKE AWAY MOUNTBATTEN COMMAND To delete 
commands within a file, position the cursor on top of the 
command and press T. The MB will say "Please Wait" and then 
"Finished" when the command has been deleted. The 
instruction is ignored if the cursor is not on a command, and the 
message "Command Not Found" is given. 

SP + E 	 	 EXIT THE MENU 

Block menu 
The block menu is used to move sections of text around the editor. You can copy, move 
and delete blocks of text. This is done using a standard "cut and paste" operation. Once a 
text is selected or "cut", it is placed in a "clipboard" from where it can later be "pasted" into 
the new location. 

Enter+B	 Enter the Block Menu: You have the following options: 
	 B	 	 BEGIN BLOCK marker. The cursor must be moved to 

the first character to be included in the block and the 
command given. The MB will say "Block Begin".The 
maximum size of the block is 1200 characters if the 
block is to be copied or moved. When deleting a block, 
size does not matter 

	 	 E	 	 END BLOCK marker. The cursor must be moved to the 
first character after the text to be included in the block 
and the command given. The MB will say "Block End".  

	 	 C	 	 COPY BLOCK to the cursor position. The block can be 
copied or moved to any cursor position other than within 
the block area itself and will be inserted immediately 
before the current cursor position.  

	 	 M	 	 MOVE BLOCK to the cursor position. The block markers 
are not deleted when a move command is given. This 
enables you to move the block to another position if you 
realise you have moved it to the wrong place. 

	 	 P	 	 PASTE BLOCK This copies any information in the 
clipboard to the current cursor position. 

	 S	 	 SPEAK BLOCK Speak the contents of a block. 
	 D	 	 DELETE BLOCK 

	 After entering any block option, you are automatically returned to the editor on 
completion of the operation. 
The document is automatically re-formatted after any of the operations, apart from the 
setting of markers. The MB says which operation is being carried out, e.g., "Move Block" 
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followed by "Please Wait" and then "finished". 
SP + E 	 	 EXIT THE MENU 

Delete menu 
The commands in the Delete Menu duplicate many of the chorded commands. This Menu 
is helpful if you need help remembering the chorded command or have difficulty pressing 
both keys simultaneously. 

Enter+D	 Enter the Delete Menu: You then have the following options. 
	 	 C	 	 DELETE CURRENT CHARACTER 
	 	 W	 	 DELETE CURRENT WORD On deleting a word, any 

attached punctuation and following spaces up to the 
next word or end of the line will also be deleted. 

	 L	 	 DELETE CURRENT LINE On deleting a line, the 
following carriage return and/or linefeed will also be 
deleted. If a page break terminates the line, then this is 
NOT deleted. 

	 	 P	 	 DELETE CURRENT PAGE. On deleting a page, any text 
between the previous page break, and the next one is 
deleted. The page break is also deleted. 

	 	 Dot3	 	 DELETE PREVIOUS CHARACTER  
	 Dots 256	 DELETE TO END OF WORD 
	 Dots 145	 DELETE TO END OF LINE 
	 R	 	 RESTORE LAST DELETION 

The document is NOT automatically re-formatted after a deletion. You must use the 
format command in the File Menu to re-format. 
SP + E 	 	 EXIT THE MENU 

Search and replace menu 
The search and replace menu enables you to search for and, if desired, replace the 
selected text. You can choose the direction of the search, the case of the text you are 
searching for, or whether it should match whole words. 

Enter+S	 Enter the Search Menu: You then have the following options. 
	 	 D	 	 DIRECTION OF SEARCH - the options are; 

	 	 	 	 Search to cursor 
	 	 	 	 Search from cursor 
	 	 	 	 Search whole file from start 
Each time you press D, an option is spoken. The last 
spoken option is the one selected. 

C	 	 CASE SENSITIVITY OF SEARCH - the options are; 
	 Case sensitive 
	 Case insensitive 
Each time you press C, an option is spoken. The last 
spoken option is the one selected. 
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	 W	 	 WORD MATCHING or not  - the options are. 
	 It matches whole words only. 
	 Matches anywhere (the word you are searching 
for can be part of another word) 
Each time you press W, an option is spoken. The last 
spoken option is the one selected. 

Note:	 	 If you start or end a search string with a space character (i.e., 
NEWLINE, SPACE, FORMFEED, etc.), the space character is treated 
as the end of a word. 

	 	 S	 	 SEARCH FOR TEXT	  
	 	 R	 	 SEARCH AND REPLACE TEXT 
	 	 L	 	 RESTART LAST SEARCH 

Before a search or replacement is initiated, the proper operating 
selections must be set up. 

Entering search and replace strings 
When you start a search, you are asked to enter the search string (the letters or words 
you seek). You may use any alphanumeric or space character.  You can look for a string at 
the end of a line by entering NEWLINE after your search word or look for a string at the 
beginning of a line by Entering NEWLINE as the first character of the search string. If you 
press Backspace, the last character entered is deleted (the MB will say the character that 
was just deleted). You cannot enter "nothing" as a search string. 
Chord-E (sp + E) terminates the search-and-replace function. 
After the search string has been entered, if you choose the replace option, the MB will say 
"Enter replace string".  The same character combinations can be used with the replace 
string. However, you can choose to have nothing as the replace string (this will delete any 
occurrence of your string in the file). To do this, enter sp+E as the first character in the 
replace string. Remember that there may be a space before or after the word you want to 
delete, so incorporate that extra space at the end of your search string. Of course, this will 
mean it will not find a match if the word is followed by punctuation. You may have to try it 
with and without the space to ensure you get all occurrences. 

Note:	 	 Keep in mind which format you are using to enter information. If you 
use Grade 2 braille, you cannot search for a word in Grade 1 braille. 

The search sub-menu 
If your search string is found in the file and this is a search-only command, then you have 
available the following options: 

	 	 W	 	 Speak word that contains the search string. 
	 	 L	 	 Speak line that contains the search string. 
	 	 N	 	 Ignore this one and find next. 
	 	 Command Key	 Stop the search and return to the main search 

menu. 
	 	 sp+E	 	 Stop the search and return to the main editor 
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The search and replace sub-menu 
If the search string is found and you have chosen to replace it,  you have available 
the above Search sub-menu options as well as the following: 
	 	 W	 	 Speak word that contains the search string. 
	 	 L	 	 Speak line that contains the search string. 
	 	 N	 	 Ignore this one and find next. 
	 	 Command Key	 Stop the search and return to the main search 

menu. 
	 	 sp+E	 	 Stop search and return to the main editor 

	 	 R	 	 	 Replace this occurrence 
	 A	 	 	 Replace all occurrences 

When you exit the Main search menu, the document will be reformatted after a 
replacement has occurred before control is returned to the editor. 

Abandoning search  
A search can be abandoned at any time, even during the setting up of the search or 
replace strings, by pressing the Command key. 
If the search string is not found, you are returned to the Search menu to change the 
search string or one of the search conditions.  
To leave the Search Menu, use the command. 

SP + E 	 	 EXIT THE MENU 

Editor definitions and concepts 
When using the Editor, there will be references to various terms and concepts you will 
need to be familiar with.  These include: 

	 Hard and soft carriage returns 
A soft carriage return usually marks the end of a line within a paragraph. It is 
automatically inserted by the editor at the end of each line.  
A hard carriage return is something you enter into text by pressing the "enter" 
or "new line" key, usually at the end of a paragraph or by inserting a blank 
line. 

	 Hard and soft page breaks 
Usually, the editor uses "soft" page breaks to distinguish the end of a page 
and the start of a new one. If subsequent text is inserted or deleted, by 
whatever means, and the document is reformatted, then the position of the 
page break changes accordingly. 
"Hard" page breaks; however, do not move. They will always force the start 
of a new page. If you wish to force a Hard page break, merely enter the 
"New Page" or "Form Feed" character from the MB keyboard or Control-L 
from an attached QWERTY keyboard. This will insert a Hard page break at 
the current cursor position.  
	  

	 Printing files 
Files can only be printed after leaving the Editor. You cannot print or emboss 
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files from within the editor. Printing of the files uses the standard PR 
command.  
Valid options for page numbering can still be used and are discussed in the 
User Guide dealing with printing files. 

	 Speaking commands 
If the "Speak Commands" option in the Speech Menu is set to YES (ON), 
then when a command is found, the word "Command" is spoken, and the 
command following is spelt. As the commands are intermingled with the text, 
it may sound strange, but it allows you to locate commands quickly. 
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Mountbatten Brailler Tutor connectivity 
Connecting to a PC using MB-Comm software 
To connect your Mountbatten Brailler Tutor to a PC or laptop, you need a USB A-B-type 
cable plus MB-Comm software. The USB cable needs to be connected to the USB B 
(slave) port of Mountbatten Brailler, next to the power adapter socket on the right side of 
the unit.  

MB-Comm software is free and available in the Resources section on the 
mountbattenbrailler.com web page. It is a Windows PC application that enables the 
transfer of files between a PC and a Mountbatten Brailler Tutor.  

To install: 

1. To use the USB connection, you must first load the Mountbatten USB drivers.  

2. Double-click the MB-Comm setup file, and the installation will begin. 

3. The installation checks your computer for Windows .NET components and loads them if 
required. This may take several minutes. 

Found a new hardware wizard. 

For the first-time USB connection of the Mountbatten to the PC, the PC will detect a new 
USB device and bring up a Found New Hardware Wizard. 

The wizard may ask to search the Web or Microsoft Update; please select "No, not this 
time" and select Next. 

Then select "Install the software automatically (recommended)". 

You may hear Mountbatten say "USB connected" during this procedure. 

Accept any prompts to "continue anyway". 

When finished, the PC should indicate that the new hardware has been installed 
successfully. 

If you encounter any problems with communication between Mountbatten Brailler Tutor or 
Mountbatten Braille Whisperer and MB-Comm software through a USB cable (connection 
errors, missing letters, or whole words during embossing), please select the option "Safe 
USB transfer" in connection settings. This setting will be stored, and you won’t need to 
change it in the future. 

Detailed instructions: 
• select "Connect Mountbatten" from the menu "Device" 
• click the button "Settings" in the displayed dialogue box 
• in the shown window, check the "Safe USB transfer" option in the section 

"Advanced settings." 
• confirm this setting with the "OK" button. 

The following screenshots show the described steps: 
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Starting MB-Comm. 
When starting MB-Comm while connected to the Mountbatten, you will hear a series of 
tones and "OK" prompts while the connection is being established. If you don't hear any 
tones, make sure the Mountbatten is on, connected, and has paper loaded; if all this is in 
place and no connection is made, contact the helpline for assistance. 

Transferring files to/from Mountbatten Brailler Tutor 
Text files can be Embossed on the MB directly from your computer or sent to the 

MB memory for later embossing. Or, files held in the MB memory can be sent to the 
Computer for saving. 

From the File menu, select either: 
• Send Text File to MB 
• Emboss File on MB 
• Receive and Save File from MB 

Hint: It is recommended that when sending to the MB, the Send Text File to MB 
function is used, as this is much quicker and allows you to Emboss the material at your 
leisure. 

Other features 
On the Computer screen, you may 

• Display File from MB 
• You can also interact with the MB through a Chat mode.  

At any time, using the Device Menu, you may turn the Embosser On or turn the 
Embosser Off. You may also Connect or Disconnect the MB or use MB Memory 
Management to report on the MB memory. File management works for all Mountbatten 
Brailler models, while the free memory field is not displayed when an MB Tutor is 
connected, due to the large size of memory in this model. 

You may also click the lights in the toolbar under MB-Comm menu to Connect and 
Disconnect or turn the Embosser On or Off. 
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MB-Comm menus 

File menu 
• Receive and Save File from MB 
• Display File from MB 
• Send Text File to MB 
• Emboss File on MB 
• Chat Mode 
• Upgrade Mountbatten Brailler 
• Save Display to File 
• Clear Display Window 
• Exit 

	  
Receive and Save File from MB        R 

This option will query the MB and pop up the list of files held in the MB memory 
when selected. Select the file you wish to send to the computer. When you click OK, the 
Windows file selection menu will pop up with the MB file name offered as the default file 
name. You may browse to another directory if needed and/or change the file name before 
saving the file. 

When you click OK, the file will be sent from the MB. The MB will beep during the 
file transfer to indicate progress. 

Once saved on the computer, the files may be edited using any Windows word 
processing program. The text editors, such as Notepad or WordPad, are convenient for 
text editing, or you can use programs like Word if you save the file as a text file. 

Display File from MB        D 
Selected from the File Menu, this function lets you view a text file sent directly from 

the MB to the computer. 
When selected, a menu will pop up showing the MB files available. Choose the file 

for viewing and click ok. The file will be sent directly to the computer screen for viewing. 
Use the Windows controls to scroll through the text. 

Note that you cannot Edit any displayed text. It is simply for viewing. 

Send Text File to MB        S 
Selecting this option will pop up a Windows file selection menu. Choose the file you 

wish to send using the Browse facility if needed. The MB will beep several times when you 
click OK and then present its file menu. You will then be asked to nominate a file name the 
MB can use. The default selection will be the Computer file name. The file will then be sent 
to the MB and stored in the MB memory with your selected file name. 

If there is any problem with the file name, you will receive an appropriate error 
message with advice. 

If the file already exists, you will be prompted to overwrite it or not. 
The MB will beep during the file transfer to indicate progress. 
You may cancel the transfer any time by selecting the Cancel button on the screen. 

The computer will stop sending, but the MB will continue to beep for a time until the buffer 
has been emptied. The MB will then be left with a partial file in memory. If necessary, you 
may Delete this file using MB Memory Management. 

Emboss File on  MB        E 
Selecting this option will pop up a Windows file selection menu. Choose the text file 

you wish to Emboss using the Browse facility if needed. 
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The file will then be sent to the MB and Embossed. If necessary, you may use the 
MB Print Control facilities to Pause or Abort the Embossing. 

Note: Ensure the MB has paper loaded and is ready to receive the file before 
sending. 

MB Print Control 
Press the Command (Control) key if you need to pause Embossing. The Embossing 

may not stop immediately but will when the buffer is emptied. You may then either continue 
embossing or abort the process. Press the New Line, Space, Enter, or Backspace key to 
continue. To abort, press any of the braille dot keys. 

Chat  Mode        M 
This is a Toggle function. When selected, it will be ticked. To de-select it, click it 

again. 
Selecting Chat Mode allows interaction between the MB and the computer 

keyboard. What is typed on the PC keyboard is brailled on the MB, and what is typed on 
the MB keyboard is displayed on the computer screen. 

Text displayed on the PC from the MB will be Grade Zero or what is known as 
Computer Braille Code. If you wish to see correct text displayed on the computer when 
using chat mode, turn on the MB back translation. 

If you wish to type on the PC and get the correct braille, turn on Forward 
Translation. 

Note: You cannot edit the computer screen. You can only translate one way at a 
time. You cannot have back and forward translations on at the same time.  

You may also send MB Commands from the PC keyboard by using the curly 
brackets "{" and "}". The opening bracket "{" substitutes for the Command key, and the 
closing bracket "}" substitutes for the Enter key. 

Upgrade Mountbatten Brailler 
This option performs an upgrade of the connected Mountbatten Brailler. This legacy 
feature works with older Mountbatten Brailler models - the Classic and Whisperer.  
MB Tutor, in production since 2020, can be updated with the use of a USB drive. 

Save Display to File        a 
You may save the text displayed by MB-Comm.  All the text viewable in the MB-

Comm window, not just the visible portion, will be stored using the save display function 
from the File menu. 

Clear Display Window        C 
All the text viewable in the MB-Comm window, not just the visible portion, will be 

erased. 
Before erasing, you will be asked to save the display contents as a text file. You 

may answer yes, no, or cancel. If you answer yes, the usual File Save window will pop up 
and prompt a file name. If no, then the screen is immediately erased. Cancel leaves the 
screen as is and waits for the following action. 

Exit       x 
You may exit at any time. If any text is displayed on the screen, you will be asked if 

you wish to save it. 
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Device Menu 
• MB Connect 
• MB Disconnect	 	  
• Embosser On 
• Embosser Off 
• MB Memory Management 

Connect remote MB      C 
This function is good for remote learning when a teacher with a PC is located elsewhere 
than the student with his MB Tutor. First, to establish such a connection, you need an 
active connection to the Internet on both the MB-Comm PC and MB Tutor. 
This mode requires an activation of the functionality by the controlling MB Tutor. 

Disconnect remote MB      D 
Choosing this option disconnects an active remote connection to an MB Tutor. 

MB Connect      M 
Connecting the MB may require setting data flow parameters, as mentioned at the 

beginning of this chapter. To do that, choose Settings in the connection window. When the 
settings window is closed, press OK to start the communication. 

For the MB, before connecting, you will be prompted to insert paper and ensure that 
the MB and Computer are correctly connected. 

You will receive a connection error if you do not have paper in the MB before 
connecting. Also, if you do not have a charging adaptor connected, ensure the MB is 
awake. Once connected, the MB will stay awake as long as the connection is maintained. 

MB Disconnect      B 
Disconnecting the MB does not exit the program; it simply breaks the 

communication between the computer and the MB and allows you to use them as usual. 
MB-Comm will merely wait for a new connection. 

Before Disconnecting, you will be prompted to confirm your action.  
This function is also available by clicking the MB Connected / Disconnected 

indicator lights. The indicator toggles according to the state of the connection. When 
connected, it will be green. When disconnected, it will be red. 

Embosser On      O 
Embosser Off      s 

This can be toggled to prevent the MB from embossing in chat mode. 
This function is also available by clicking the Embosser Off / On indicator light. The 

indicator toggles according to the state of the embosser. When on, it will be green. When 
off, it will be red. 

If sending files to the MB as opposed to embossing, then regardless of whether 
embossing is on or off, the file will be sent without embossing. 

MB Memory Management        e 
Selected from the Device Menu, the MB will beep several times as MB-Comm 

gathers file information. 
A list of the files held in the MB memory will be shown. 
If you make a mistake and delete a file you should not have, you can un-delete it, 

provided you do it immediately after you complete the error. 
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MB-Comm's menu contains options for Mimic - a legacy device that can be 
connected through the serial port of your PC. These are not relevant to 
Mountbatten Brailler Tutor and should be included in this manual. 

Connecting to iOS or Android devices 
MB Tutor is equipped with Bluetooth to connect to smartphones and tablets that work with 
mobile operating systems: iOS or Android. A free app is available in the Apple AppStore 
and Google Play Store: MBMimic. The MBMimic is a communication app that supports 
producing hard copy braille output and interaction with a braille user. The app can be 
operated by the sighted and the blind. It is fully accessible when VoiceOver is running on 
your iOS device.  

With the MBMimic, you can:  
1. Create a list of users (e.g., students)  
2. Assign folders with specific content to each student  
3. Transfer files among your students  
4. Transfer files from apps like documents to MBMimic  
5. Retrieve files from your students’ Mountbatten 
6. Read files stored in your students’ Mountbatten 
7. Send files to your students’ Mountbatten 
8. Email files retrieved from the Mountbatten 
9. Emboss files stored on your iOS device  
10. Chat with the Mountbatten user using the chat application  
11. Help your students learn to spell words using the Whiteboard application  
12. Check if your student can read contracted or uncontracted braille  

MBMimic comprises three tabs: Active Users, Archived Users, and Mountbatten. The 
Active Users tab is meant for lists of users, e.g., students, who actively use the 
Mountbatten.  

The Archived Users tab was created to let the teachers keep information from previous 
years so as not to interfere with current users.  

The Mountbatten tab is used to establish a connection with the Mountbatten, interact using 
the Chat or Whiteboard applications, check the Mountbatten’s memory, or find out the 
firmware version of the Mountbatten unit.  

To run the app, locate it on your iOS device, tap it, and wait for it to open. Tap one of the 
three tabs you want to work with at the bottom of the screen.  

Active Users  
When you tap the Active Users tab, you will see a long button Add user... Tap this button to 
open the Edit user box, where you are asked to enter the full name of the user as well as 
the display name. Once you have completed the information, tap Done, and your first 
active user will be added to the list.  

NOTE: It is recommended but unnecessary to complete all the fields in the Edit user box.  
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To add more users, tap the plus sign (+) in the top right corner of the screen and follow the 
same steps.  

When you have created your user list, you can organise their files by creating folders.  

First, tap a user to open the main folder. Next, tap the plus sign and select from the menu 
to add a folder or a file from the Mountbatten. Tap Add folder... and when a small box pops 
up, type the name of this new folder. Tap OK to finish.  

The folders and files can be deleted when they are no longer needed. First, tap the Edit 
button next to the Add button (the plus sign). You will notice red round icons pop up on the 
left-hand side. The Delete button will appear on the right-hand side when you tap on it. 
Use this button to continue deleting. You will be asked again to confirm your decision. Tap 
the Delete button to remove the item.  

There is also another way to delete an item. After tapping the Edit button, tap on the item 
you want to delete. A three-option menu will pop up. The topmost option is Delete. Tap it, 
confirm your selection, and the item will be deleted.  

The same method lets you move or rename the item. You can move a folder or a file to a 
different user. When you have tapped the Move option in the menu, you will be given a list 
of users to which you can move the item. Once you tap on a different user, the item (file or 
folder) will be transferred to a new location.  

Files stored in the User's main folders or subfolders can be manipulated in several ways.  

Once the file is tapped, a file menu opens up with the following actions:  

• View – preview the content of the file 

• Send to Mountbatten – send to Mountbatten Memory 

• Move – move to a different location  

• E-mail – send it by e-mail 

• Emboss – emboss on the Mountbatten  

NOTE: In the Send to Mountbatten and Emboss case, if your MBMimic is not connected to 
a Mountbatten, the connection process will begin before the selected action is executed.  

Connecting to a Mountbatten Brailler  
Before connecting to a Mountbatten Brailler, please make sure that the Brailler is turned 
on and the paper is loaded.  

Tap on the Mountbatten tab at the bottom of the screen of your iOS device. The program 
will be looking for any active Mountbatten in the vicinity. After a list appears, select the unit 
you want to connect to. A connection screen will show up saying "Connecting to 
Mountbatten". You should hear the Mountbatten beep several times, and after a few 
seconds, your MBMimic will connect with the Brailler. Tap Done, and you will be taken to 
the home screen.  
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NOTE: The MBMimic looks only for a Mountbatten. It will not display any other Bluetooth-
enabled devices, so you never have to browse through long lists of devices to find the one 
you want to connect to.  

From now on, you can begin interacting with Mountbatten.  

The home screen gives you the following options:  

Chat – an application for chatting between the Mountbatten and iOS users  

Whiteboard – an application for various writing activities between the Mountbatten 
user and the iOS user  

Connection status – shows whether you have successfully connected to a 
Mountbatten 

Files – this option shows how many files are stored in Mountbatten memory; the 
show button allows you to open the Mountbatten directory listing the files stored in 
its memory  

Language – this option informs you about the default language  

Braille table – this option tells you about the default braille table  

Mode – this option shows you which mode the Mountbatten is currently in; it can 
be either learn or advanced  

Firmware – this option provides information about the firmware version model – 
this option shows the model version of your Mountbatten serial no: - this option 
provides the serial number of your Mountbatten  

  

The Whiteboard  
When you tap on the Whiteboard application, a new screen opens with an edit area and a 
screen keyboard. Every word you type will get embossed after the space bar is pressed on 
the screen keyboard. Similarly, every word that gets brailled on the Mountbatten will be 
displayed on the screen once the user presses the space key on the Brailler wireless 
keyboard.  

Two buttons in the top right corner – Grade 1 and Grade 2. These two buttons correspond 
to contracted and uncontracted braille output, respectively. When you want your braille 
output to be contracted, make sure the Grade 2 button is pressed.  

The Chat  
When you open the chat program, you will see a large white field, an edit box, and a 
screen keyboard. The text is entered into the edit box, but it will not be embossed until the 
Enter key or the OK button is tapped. When the Mountbatten user is brailling their entry, 
the text will be displayed only after the New Line key is pressed on the Brailler.  

Two buttons in the top right corner – Grade 1 and Grade 2. These two buttons correspond 
to contracted and uncontracted braille output, respectively. When you want your braille 
output to be contracted, make sure the Grade 2 button is pressed.  
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Embossing on Mountbatten Brailler  
A. Embossing directly after transferring text to MBMimic.  

1. Turn the MB Brailler on.  

2. In the MBMimic app, find the file that you want to emboss. Tap this file, and a menu 
will open up. Select Emboss.  

3. The "Connect to Mountbatten" dialogue will open up. Wait a few moments until your 
Mountbatten Brailler shows up on the list. Tap the serial number that pops up. You 
will hear the Mountbatten beep several times.  

4. You will be asked if you want to translate the file to Braille. If your text does not 
have any embedded commands and was created in a standard print format, it is 
recommended to choose Yes - use forward translation to braille.  

5. Once you tap your option, the Mountbatten will begin to emboss.  

6. When the first page is embossed, insert a new sheet of paper. The embossing will 
resume automatically.  

Transferring files from Mountbatten to MBMimic.  
1. Run your MBMimic and make sure the Mountbatten is also switched on.  

2. Select the Mountbatten tab at the bottom of the screen after establishing a 
connection between the MBMimic and the Mountbatten. Locate the Show button 
and tap on it.  

3. A list of files stored in your Mountbatten will show up. Please select the one you 
want to transfer by tapping on it and choosing View from the menu.  

4. The content of the file will open up. In the top right corner, find the Save button. You 
will be moved to the Active Users tab when you tap on it. Select the student whose 
folder you want to transfer the file to, then select the location and tap the Save here 
button.  

5. Then tap the Done button in the following two dialogues to complete the transfer. To 
check if the file was moved, go to Active Users and locate the file in the previously 
selected directory.  

Connecting to printers 

Connecting to printers (the black-print ink or laser printers used with regular computers) is 
easy and is fully automatic - you need to connect a USB cable between the printer and the 
MB Tutor USB port on the left side of the unit. If connected for the first time, loading drivers 
and installing the printer may take several minutes (even more than 10 minutes 
sometimes). Connecting the MB to the Internet to make more drivers available if the printer 
is a new or rarely used model is recommended. After installing the printer, you may use 
back translation features to print from the MB Tutor memory to the printer.  
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Connecting to the Internet 

You may use the Wi-Fi hub at work or study to connect to the Internet. You will need the 
advanced Mountbatten Brailler Tutor functions enabled (it may take a few minutes after 
you switch the unit on before you hear the "Advanced Mountbatten Brailler Tutor functions 
available now" message). Go to the System menu and choose Wi-Fi settings. You should 
see a list of available Wi-Fi networks. If the one you want is not listed - you may refresh 
the list (the first option in the submenu).  

After you have found your network, choose it with the Enter key, and you will be prompted 
for a password. There is an additional switch under the network list to show or hide a 
password while entering. The password may include some special characters. In that 
case, entering may be challenging, depending on the Braille table used. To make it easier, 
prepare a file called MBT_Network.txt and place it in the root folder on a pen drive to be 
plugged into the left-side USB socket of MB Tutor. The file should include the following 
information: 

Network=<<network name>> 
Password=<<password>> 

To connect to the network defined in the MBT_Network.txt file, please place the pen drive 
into the left-hand USB socket and go to Menu -> System -> Wi-Fi -> Read network 
credentials from a file. 

Advanced users may enter two more optional lines for networks that need specific 
parameters: 

Authentication=<<security>> 
ConnectAutomatically=<<automatic_connection>> 
where: 

<<security>> is one of:: 

	 0 for Open network 
	 1  for WEP 
	 2  for WPA 
	 3  for WPA2 Personal (this is the default setting) 
	 4  for WPA2 Enterprise 

<<automatic_connection>> is one of: 
	 0  for non-automatic connection 
	 1  for automatic connection (this is the default setting) 

Here is an example of the network parameters definition file: 

Network=My_net 
Password=Alice1409 

The connection should operate immediately after you give the correct password.  
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MB Tutor and Duxbury Translator  
MB Tutor connects to PC with Duxbury Translator installed over a USB cable. While 
connecting, remember to set the hardware parameter "Flow Control" to "None". All other 
settings should stay default.  

Here is a step-by-step instruction for embossing a text using the Duxbury Translator: 

1. On your Windows machine, install the USB driver for MB Tutor and have 
Duxbury installed. 

2. Define the printer in Duxbury: 

• From the menu, select Global > Printer Settings… 

• The "Global: Printer configuration" dialogue box appears. In this window, use 
the "new" button 

• The "Global configuration - Untitled configuration" dialogue box will appear. 

• From the "Embossert model" drop-down list, select the "Quantum 
Mountbatten" printer (device) 

• The "Setup name" edit field can be left blank 

• In the "Output options" group, select "Writing to port" 

• Use the drop-down list to select the serial port number for the connected 
machines 

• After the serial port is set, the "Serial" group will appear. In this group, please 
change the value of the "baudrate" item from 9600 to 115200 and the 
"handshaking" option from "hardware" to "none" 

• Confirm with the "OK" button 

• After confirming the printer configuration, you will return to the "global: setup" 
dialogue box. Here, from the "Braille device" drop-down list, select the 
"Quantum Mountbatten" option and define parameters such as page size, 
number of lines on a page, number characters per line, and top margin 

• Now you can emboss using the Mountbatten Brailler Tutor.  

Please remember that changing the settings in the "Global" window does not apply to the 
document file we are working on. To run the document converted for Tutor, use the 
necessary parameters in the Document menu > Braille embosser configuration. 

Please check the Duxbury User Manual for more information on printing braille texts from 
a PC with Duxbury Translator to Mountbatten Brailler Tutor. 
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Updating your Mountbatten Brailler Tutor 
Updating your MB Tutor may be done on three levels: 

- Basic Mountbatten Brailler Operating Firmware 

- Advanced Features Software Firmware  

- Games 

You can access this feature from the System menu, Update device or Update advanced 
module option. 

Each level is updated differently: 

Updating Basic Mountbatten Brailler Operating Firmware 
You need the firmware update file set from the Producer of Mountbatten Brailler Tutor to 
update the basic firmware. It comes in a folder named MBUPDATE.TUT . It should be 
placed in the root of a USB drive memory that needs to be placed in the upper USB socket 
on the right side of your MB Tutor. While the USB drive is placed in the socket (when Tutor 
is on), you will hear a "USB memory connected" message. Choose menu System -> 
Update device. After an additional prompt, the update process will start automatically.  It 
may take several minutes, but up to an hour with some large audio updates. 

When the basic firmware update is done, the unit will automatically restart. 

Note: If a USB drive memory is removed from its USB socket after an update command is 
issued, the device may get in an endless loop, expecting the update file where it should 
be. To get out of the circle, you need to place memory in a USB socket with the proper file. 

Updating Advanced Features Software Firmware and Games 
To update the advanced firmware, you either need the firmware update file set from the 
Producer of Mountbatten Brailler Tutor or set up the Internet connection. 

Updating from a file on USB pendrive: 
The advanced firmware update comes in a folder that should be placed in the root of a 
USB drive memory that needs to be placed in the  USB socket on the left side (different 
from the basic software) of your MB Tutor. While the USB drive is placed in the socket 
(when Tutor is on), you will hear a "USB memory connected" message. Choose menu 
System -> Update device -> Update advanced module -> Update from USB memory. After 
an additional prompt, the update process will start automatically.  

When the advanced firmware update is done, the unit will restart its Advanced Functions 
Engine and get ready to work. 

Updating from the Internet: 
The advanced firmware update is placed on a server in the cloud, and the Tutor can find it 
if it is connected to the internet. MB Tutor will determine the newest firmware and update it 
automatically. Choose menu System -> Update Advanced Functions Firmware -> Install 
from the Internet. After an additional prompt, the update process will start automatically.  
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When the advanced firmware update is done, the unit will restart its Advanced Functions 
Engine and get ready to work. 
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Making braille graphics  
The following formatting commands apply in both Learn and Advanced Mode. 
	 	  
Menu: Emboss/Graphics mode toggle 

GF     	Graphics mode.  In Graphics Mode, the space between the dots is reduced, 
giving the appearance and feel of lines instead of dots. There is much scope 
for creativity, and learning about braille graphics re-enforces the braille code 
for the braille learner. Default = off. Toggle 

Note: 	There are dedicated braille graphics programs that you can run on your PC, 
such as TactileView. Another exciting way to make tactile diagrams is using 
"swell’ paper and the Pictures in a Flash - PIAF.  For more information on 
either of these products, please refer to our website int.harpo.com.pl  
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Technical Specifications  

Power: proprietary power supply 110v – 220v Output 15-19VDC 5.5Amp, 90W) 

Battery life: 20 hours standard use, 5 hours or 70 pages embossing 

Weight:	 3.9 kg  (8.6 lbs) 

Operating temperature: 10 ~ 40 ˚C   (50 - 104 ˚F) 

Size [mm]:
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